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Gordon
Mah Ung

THANK YOU,
COMMODORE 64

solid blue-collar roots, and
throwing money around on something
as frivolous as a personal computer in
the 1980s likely made no sense to my
immigrant parents. Up to that time,
their only exposure to technology was
the spiffy Texas Instruments calculator
my dad bought to literally replace his
abacus.

But somehow in 1982 my parents
ponied up the $595 to buy me a Com-
modore 64. It wasn't my first computer,
either. Jack Tramiel’'s Cé4 followed a
VIC-20 purchased two years before for
$299.95.

To put those purchasing decisions
in perspective, $595 in 1982 buys you
$1,418.66 today when adjusted for infla-
tion. That VIC-20? $837.55. While | al-
ways thought my incessant whining led
to those large outlays of cash, | know
now that my parents were investing in
my future.

That Commodore 64 and VIC-20 ex-
posed me to programming concepts and
taught me typing and word processing.
And with the 300 Baud VIC modem, |
learned how to troll—er, debate—peo-
ple on dial-up Bulletin Board Systems.
| even learned not to be afraid to grab
a screwdriver when things didn't work.
Tip: RF insulation made from sloppily
cut, foil-coated cardboard isn't a good
idea inside a computer, Mr. Tramiel.
With 30 years of computing behind me to
look back on, | can say that $1,418.66 in-
vestment has paid for itself many times
over.

N submit your questions to:

Amazingly, | believe the life-chang-
ing capability of a personal computer
still exists. While other technology toys
grab the headlines today, it's the per-
sonal computer that still has the ability
to take you to magical places. You don’t
just consume with the personal com-
puter, either, you can also create. From
3D modeling to stunning digital images
to programming, and yes, of course, to
gaming, the personal computer takes
you there.

My own children are being exposed
to technology at a far younger age
than | was, but I'm going to make cer-
tain that their tech experiences aren’t
just through game consoles, tablets,
or smartphones. A personal computer,
with its limitless horizons and, yes, its
need for maintenance, will also be in my
kids’ lives. Perhaps I'll take home the
Commodore 64 from this month’s Build
It (page 60) and insist that if they want
to check out something on the Internet,
they first build the device on which they
search for it.

Gordon Mah Ung is Maximum PC’s
deputy editor, senior hardware expert,
and all-around muckraker.
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of
gamers stayed up late,
ready to fire up their pre-
downloaded copies of Diablo
IIl. They were excited to
return to Sanctuary after a
12-year absence, and to slay
hordes of ghouls, demons,
and abominations alongside
their fellow adventurers.
What they got instead was
a server error—a message
informing them that because
Blizzard was struggling with
the huge load of players,
they would be unable to
play the game that was
sitting, freshly installed,
on their hard drives. Even
the single-player game
was unavailable, thanks to
Blizzard's new form of DRM
that requires a constant

connection to its servers for
any type of play.

The server problems had
been mostly resolved by the
next day, but the experience
raised concerns about sev-
eral trends in PC gaming.

The first is the new breed
of DRM that requires a con-
stant Internet connection.
It's effective at preventing
piracy and cheating (the Bliz-
zard implementation actually
keeps some core game logic
on the servers, preventing a
simple crack from circum-
venting the need for a con-
nection), but bad for gamers.
The game cannot be played
anywhere without an Internet
connection, and attempting
to play on an unreliable con-
nectionis liable to get a gam-

try again later

Welcome to the real depths of hell in Diablo lll.
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er kicked out of the game
mid-dungeon. Additionally,
as the Diablo Ill launch dem-
onstrated, any problems with
the publishers’ servers mean
it's game over for everyone,
whether or not they want to
play online.

The likely motivation be-
hind Blizzard’'s new DRM,
and another worrying trend
in PC gaming, is the Dia-
blo Il real-money auction
house. Whereas Blizzard's
stance in World of Warcraft
has always been that it's
against the terms of ser-
vice to trade in-game goods
for real money, it's done an
about-face in Diablo Ill, cre-
ating a sanctioned online
auction house where play-
ers can buy and sell game
items for cold, hard cash.

Blizzard will take a por-
tion of each sale, amounting
to $1 per equipment trans-
action, and then take anoth-
er 15 percent if you choose
to cash out your account
balance. Activison Bliz-
zard stands to make a lot of
money from the real-money
auction house, as long as
the in-game economy re-
mains strong. Of course,
nothing can ruin a game's
economy faster than cheats
and exploits—exactly the
sort of thing Blizzard’'s ex-
treme new DRM prevents.

What the launch of Blizzard's action RPG says about our
favorite hobby

It could be argued that
a more secure online play
environment benefits ev-
eryone, but is it possible
for any company to maintain
100 percent game server
stability? If anyone could
do it, you'd think it would
be Blizzard, who maintains
World of  Warcraft—the
most popular MMO in the
world, with more than 10
million players. Further, the
company had a good idea of
how popular the Diablo Ill
launch would be: It was the
most pre-ordered PC game
in history on Amazon, and
Blizzard itself had given
free copies of the game to
all 1.2 million World of War-
craft annual pass subscrib-
ers, virtually guaranteeing
a massive launch.

If it's not possible for
a company as big as Bliz-
zard to keep its servers up,
what will happen to games
by smaller studios that
implement the same DRM?
What will happen to older
games when the companies
that publish them no longer
want to maintain a server
farm? And most important-
ly, is any of this fair to gam-
ers, who just want reliable
access to the games they
pay for? -Alex Castle



Ivy Bridge:
Now with Dual
Cores

Lower-power users are finally
getting their taste of lvy Bridge
with Intel’'s new line of dual-core
processors based on the 22nm lvy
Bridge cores. Intel has announced
that no fewer than 14 dual-core
vy Bridge processors will join its
lineup this summer.

Like their quad-core breth-
ren, the dual-core chips will offer
roughly a 10 percent increase in
x86 performance when compared
directly with Sandy Bridge chips.
The graphics core, however, fea-
tures far more performance,
causing Intel to label the lvy Bridge
a “tick-plus” part. Expect these
chips to be powering the next gen-
eration of Ultrabooks, most likely
alongside ultraportables featur-
ing AMD'’s Trinity APU, which itself
should debut by the time you read
this. -GU

Google, MS
Trade Wins,
Losses

The geek community at large is
pretty loyal to the Google brand,
but Bing is picking up steam.
According to a Hitwise report,
Bing now accounts for 30 per-
cent of all U.S. web searches,
and most of the gains seem to
have come at the expense of
Google. While Bing grew its U.S.
search queries by an impres-
sive 11 percent over the last 12
months, Google dropped by the
exact same amount.

On the other hand, Internet
monitor StatCounter reports
that Chrome has finally over-
taken Internet Explorer as the
most-used browser. Other In-
ternet trackers still show IE
with the lead, but Microsoft's
browser has clearly lost its
once-formidable edge. -KS

Tom
Halfhill
Fast
Forward

PARALLEL
PROGRAMMING
FOR DUMMIES

seems like rocket
science to most people, but even rocket sci-
ence can be made easy. Heck, | was building
and launching model rockets as a teenager.

Intel has invented the model rocket of
parallel programming. An Intel Labs proj-
ect, code-named River Trail, has created a
JavaScript extension that brings data paral-
lelism within reach of millions of ordinary
programmers. If an international standards
body approves, the extension could appear
in all web browsers that support JavaScript,
which is virtually all web browsers. (Don't
confuse JavaScript with Java, a completely
different language.)

River Trail is surprisingly simple and
powerful. It adds one new array type (Paral-
lelArray) and nine methods for manipulating
the array’s data. It's so simple that Intel’s
technical document is only 17 pages long.
(My digital camera manual is 150 pages.)

At May’s GPU Technology Conference, Nvidia revealed the GPU virtualization capa-
bility built into its Kepler GPUs. The virtualization technology, dubbed Nvidia VGX,
enables GPU acceleration of virtual machines. VGX allows server-side Kepler GPUs
to render their frame buffers directly to an on-GPU H.264 encoder, which then
streams the output to the remote user via, for example, Citrix Receiver. Previous VM
and remote-desktop solutions required the local CPU to render the desktop environ-
ment, leading to laggy, low-quality desktop environments. The new GPU-accelerated
remote desktops and virtual machines will enable power users to get actual work
done—or allow up to 100 virtual desktops to be rendered by a single card.

Nvidia also announced GeForce Grid—a tech to deliver streaming games to con-
sumers on thin clients, like phones, tablets, and laptops. Like the enterprise tech,
GeForce Grid uses servers with Kepler GPUs to render game video server-side and
stream it to clients, relieving the need for powerful hardware on the client end—simi-
lar to OnLive’'s streaming game service. Nvidia’s GTC demo of GeForce Grid included
a gamer playing Hawken on a TV against one playing on an Ultrabook, using the Gaikai
cloud gaming service,
which runs on GeForce
Grid servers.

One thing Nvidia didn't
mention, but we'd like SYSTEMMEMORY
to see, is whether con-
sumer Kepler cards can
utilize VGX. We envision
a world in which a gamer
can remote into his or
her desktop PC from a
smartphone or tablet
and play games acceler-
ated by the desktop GPU.
-NE

Yet River Trail can use multiple CPU cores
per chip, multiple threads per core, multiple
processors per system, and multiple-data
instructions, such as those in Intel's SSE
and AVX extensions. The latest version even
uses the GPUs in vy Bridge processors.

The best part is that JavaScript program-
mers see none of this complexity. They
simply put their data into a ParallelArray
and call one of the nine parallel-processing
methods (or multiple methods). At run time,
the JavaScript extension finds any parallel
resources available in the system and uses
them to crunch the data.

Yes, programmers must learn some new
concepts and rewrite some code. River Trail
isn't the long-sought “magic compiler” that
automatically converts existing sequential
code into parallel code. And JavaScript is a
relatively slow language, so River Trail isnt
the swiftest solution. It's a model rocket, not
a Saturn V.

But the basic technology is applicable to
other programming languages, and it really
works—I've tried it. Someday, River Trail
may bring parallelism to the masses.

NVIDIA V( Display

Tom Halfhill was formerly a senior
editor for Byte magazine and is now
an analyst for Microprocessor Report.

By encoding the video output to H.264 directly on the GPU, Kepler
can stream high-quality GPU-accelerated video to any device.
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Thomas
McDonald
Game
Theory

WEAPONIZING
ONLINE REVIEWS

opinion and critical reviews
are at odds, it's worth trying to learn who's to
blame: a suppliant press, or a raging and in-
fantile fanbase?

Or, in the case of Diablo IIl, a bit of both.

| don’t think always-on DRM is such a hot
idea, but it's Blizzard's game, and if they feel
it's necessary to protect the integrity of both
the product and the forthcoming real-money
auction house, and can get it to work, that's
their call. At this late date, no one is buying Di-
ablo Ill without foreknowledge of the DRM is-
sue, so you either suck it up knowing that’s the
price of admission, or you just shut up about it
and buy another game.

Or, you choose option three: Spam public
review sites with hostile “reviews,” calling
D3 a horrible, awful, hateful sack of pus that
probably causes cancer and shingles and kills
kittens for fun. And then give it a score of “0,”
not because of any inherent problems with the
design or content, but because you want to
punish the publisher.

On the other hand, perhaps if more voices
in the mainstream press had paused a little
longer over the day-one server problems and
DRM complaints, consumers wouldn't have
erupted into such a hissy fit.

But probably not. There's a metagame that
surrounds every huge, highly anticipated re-
lease, and it involves endless complaining, nit-
picking, hyperbole, and comment-spamming.
Some PC gamers seem to prefer this to actu-
ally playing the games.

I'm supposed to understand these out-
bursts as a form of consumer protest, but
this kind of protest is not nuanced thought.
It's reactionary. In the case of public D3 re-
views, it tells us nothing more than “People
don’t like DRM.”

It also totally compromises the tools that
allow the public to evaluate products. It's a
way of weaponizing public review systems like
Metacritic and Amazon, rendering them inca-
pable of conveying useful information. If con-
sumers want to have some kind of grassroots
alternative to mainstream reviews, perhaps
destroying the credibility of the online review
process isn't the best way to start.

You can follow Thomas McDonald on
Twitter: @StateOfPlayBlog.

If you're getting sick of waiting for a slice of your very own Raspberry Pi mini-PC, fear
not. Via, the longtime mobo maker, just announced its Pi-like APC 8750 board, a $50
Android-powered PC complete with processor, memory, and a host of I/0 ports.
The Via APC fits into any Mini-ITX or microATX case, even though it's based on a
new “Neo-ITX" form factor measuring just 17x8.5cm.
This particular Android 2.3 Gingerbread variant has &
been optimized for keyboard and mouse input. The
mini-PC sports four USB 2.0 ports and HDMI, VGA,
Ethernet, microSD, and audio/mic connections.
The APC rocks an 800MHz Via
processor along with 512MB
of DDR3 and 2GB of NAND.
It's capable of pumping out
720p graphics via its HDMI
port; that, combined with the
Ethernet connectivity, may just
make the APC 8750 an attractive little $50 media
streamer for Netflix lovers and HTPC enthusiasts on
a budget. Via expects the APC 8750 to start shipping in
early July. -BC

DDR4 DRAM Coming in 2013,
Micron Says

What does the future of memory look like? NAND flash? Hybrid memory cubes?
Memory maker Micron has its hands in both of those technologies, but it's also
banking on a third form. The company announced that its “first fully functional
DDR4 DRAM module” is up and running and should make it to market in 2013.

DDR4 has higher clock speeds and data transfer rates than DDR3 while simul-
taneously using less voltage than its predecessor, although the final standard for
the DDR4 format isn’t expected to be formalized until later this year.

Micron plans on rolling out DDR4 RDIMMs, LRDIMMs, SODIMMs, and UDIMMs—
enough acronyms for you?—with initial buyers coming from the enterprise and
server markets, then trickling down into consumer and mobile markets. Micron
hopes to kick the 4GB DDR4 modules into full-on production in the fourth quarter
of 2012.-BC

Are you ready for the second coming of Google
TV—the service that lets you conduct searches
and access web content from your television?
Well, ready or not, Google TV is once again on
the horizon, and this time it will be LG making a
big push to promote the platform, not Logitech,
which had some harsh words for the service
after being burned by weak sales and saddled
with millions of dollars in unsold inventory.
That's allin the past as far as LG is concerned.

“Production of Google TVs will start May 17
from our factory in Mexico, and U.S. consumers
will be able to buy the product from the week of
May 21,” Ro Seogho, a senior LG executive, re-
cently told a handful of reporters, according to
Silicon Valley's Mercury News. -PL
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MY WAY OR THE
HIGHWAY

month’s column. Are
you seated comfortably? Well, stop. Stand
up at once, or you'll be guilty of infringing
my copyright. That's right, it's part of the
terms of using my intellectual property—
if you're not standing, preferably uncom-
fortably, you don’t have permission to read
my column.

This is roughly the legal theory behind
the recent suit filed by the major networks
against Dish Networks, who have built a
DVR that lets their customers skip com-
mercials when they sit down to watch
prime time shows later. But I've decided
this is my favorite copyright legal theory,
because it gives me, the copyright holder,
control over you, the copyright consumer.

The networks have long claimed that
skipping commercials is tantamount to
theft, because they don’t want you to do
it. This idea runs afoul of several court
decisions, including the famous Beta-
max case and decisions like Cablevision,
which held that Fair Use gives you choices
in how and when you decide to watch your
TV, and copyright holders can’t take that
away. But they keep filing suits about it,
and winning by bankrupting the other side
with legal fees.

Are you still standing? Good. You'll like
this next part. The studios went so far as
to include details in court filings on how
they make money on content—implying
that anything that interferes with their
business model is de facto copyright in-
fringement.

Dish has sensibly pointed that that all
their content is licensed, their equipment
is legal, and skipping commercials is
probably the most universal of American
traditions. But as an intellectual property
creator, I'm intrigued by this idea that you
have to consume my content my way, so
I'm siding with the networks on this one.
So, dear reader, as we wind to the end of
this column, do the Funky Chicken or I'm
suing you.

Quinn Norton writes about copy-
right for Wired News and other
publications.
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With the Release Preview of Windows 8 now here, excitement is building over the
launch of the final product (presumably this fall). Nevertheless, there are some de-
velopments to the OS that are already causing concern. Mozilla, for one, is rankled
by news that Windows RT, the version of Win8 for ARM, will be limited to using
Internet Explorer in the “Windows Classic” environment. Mozilla general counsel
Harvey Anderson calls it an “unwelcome return to the digital dark ages where users
and developers didn’t have browser choices,” and he questions the antitrust implica-
tions. So far, Microsoft is not commenting on the matter.

According to DigiTimes, low-cost PC vendors are fretting over the pressure
they're feeling to incorporate touchscreens into upcoming Windows 8 notebooks in
order to take advantage of the Metro interface. The added cost has the potential to
price their products out of the mainstream, greatly diminishing demand.

Finally, consumers might be disgruntled by news that Microsoft will charge new
Win7 PC buyers $14.99 to upgrade to Windows 8 when it's released, whereas previ-
ously such an upgrade was free. The upgrade is to Windows 8 Pro, regardless of the
original version. -KS

AMD Slackens Catalyst Schedule

According to a post on AMD’s blog, the company is going to cease its stringent
monthly GPU driver-release schedule and instead release new Catalyst drivers
“when it makes sense.” The change starts with Catalyst 12.6, recently released as
beta. The move could signal that AMD is much more confident in its driver develop-
ment, or that the company is feeling stretched for resources. In researching AMD’s
upcoming dual-GPU card for our GTX 690 story (page 36), a source informed us that
the Trinity APU was taking engineers who would otherwise be developing GPU driv-
ers. Of course, if a less frequent driver schedule doesn’t leave gamers waiting on
much-needed fixes, the reasons for the change don’t matter. -KS

Intel’s vaunted Thunderbolt technology will no longer be exclusive to the Macintosh.
Motherboard vendors have begun integrating the high-speed 1/0 chip into board designs.
Asus, Intel, Gigabyte, MSI, and other board vendors have all announced integration
of the new interface. Thunderbolt promises speeds as high as 10Gb/s in each direction,
which is theoretically twice the speed of current iterations of USB 3.0. The boards, such
as Asus's P8Z77-V Premium (pictured below) are integrating Intel’s Cactus Ridge chip,
which greatly lowers the price of the controller.

0ddly, Thunderbolt is currently limited to machines with integrated graphics parts,
such as Ivy Bridge or Sandy Bridge. That leaves the performance X79 and Sandy Bridge-E
parts in the cold. -GU




THAT PROVED WRONG

According to the Wall Street Journal, in February
2011 Facebook was in talks to buy out Twitter to
the tune of $10 billion. It never happened.

Apple fanboys were positive that a 2011 iPhone 5 would
feature edge-to-edge glass, a new teardrop case, and
the answer to all their dreams. Maybe the rumors will
be right this year... maybe not.

Sureitis.

The Pirate i’Bp

Nothing but sweet, sweet science was created when

CERN turned on the LHC for the first time in 2008. Despite the rumor that spread earlier this

year, RIM seems determined to go it alone.

It seemed like
the long over-
due game might
remain vaporware
when publisher
3D Realms closed
down. Unfortu-
nately for all of us,
the Duke lived on.

In February, the Interwebz
were abuzz with talk of a
Steam-branded PC-centric
gaming console. Sadly, the so-
called "Steam Box” was just a
device to test new Steam Ul.

Scuttlebutt about an ac-

quisition has periodically
L” D 'LJ :A ' surfaced over the years, but
@ Nvidia remains its own boss.
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Rumored 2005 purchase
never happened. And man,
we're all the better for it.
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BY BRAD CHACOS

After years of rumors and whispers, Google finally released its long-awaited Google
Drive cloud storage service in April, combining Dropbox-like synching abilities and a
PC client with the company’'s Google Docs service. Microsoft could have waved the
white flag; instead, it released an excellent update for its own SkyDrive service, adding
many of the features found in Google Drive. The chips are on the table and there’s only
one question left: Which cloud storage service is better?

Round 1: Interface

Microsoft and Google must've
done their homework before
launching GDrive and Sky-
Drive, because the PC and
Mac clients for the respective
services look and feel an awful
lot like Dropbox’s. Basically,
each appears as just another
folder on your computer, al-
beit a folder that seamlessly
syncs with the cloud whenever
somethinginside of it changes.
The synched folders even ap-
pear in Windows Explorer’s
Favorites sidebar just like
Dropbox’s client. It's painless
and wonderful.

It's a toss-up on the web
interfaces, too. Both have sim-
ple, flexible, and functional Uls
that deliver all the information
you need without being overly
busy. Both also feature list-
and thumbnail-style viewing
options. We prefer SkyDrive's
colorful look to Google Drive's
drab hues, but that's just a
matter of personal taste.

Round 2: Storage/Price
New SkyDrive sign-ups re-
ceive 7GB gratis—compared
to the free 5GB offered by
Google Drive—and veteran
users can opt to grandfa-
ther in their full 25GB of free
space. Plus, SkyDrive's up-
grade options are cheaper
than Google Drive’s, and un-
like Google, Microsoft offers
a 50GB plan.

Google Drive outshines
SkyDrive in the total amount
of upgradable space available,
however. SkyDrive tops out
at 100GB, while Google Drive
goes all the way up to a whop-
ping 16 terabytes (for a simi-
larly whopping $800/month].
Also, Google Drive caps file
uploads at 10GB, compared to
SkyDrive's 2GB max.

We think 100GB of cloud
storage is more than enough
for most people, though. Sky-
Drive's cheaper prices and
more generous free storage
earn it the win.

Round 3: Platform
Support

Part of the allure of synching-
style cloud storage solutions
is the ability to access your
files from virtually anywhere.
Both services have Windows
and Mac desktop clients while
neglecting Linux lovers (who'll
have to stick to Dropbox). The
real difference lies in mobile
support: SkyDrive offers dedi-
cated i0S and Windows Phone
apps, while Google Drive only
has an Android app. Neither
has announced plans for Black-
Berry support.

As it stands, SkyDrive gets
the nod for supporting two mo-
bile platforms, including the
Uber-popular i0S, and for its
deep-rooted Windows 8 inte-
gration. An Apple-compatible
app—which Google says is in
development—will add a lot of
appeal to Google Drive, though
both services pale compared
to Dropbox and SugarSync’'s
widespread mobile support.

Round 4: Collaboration

Both services offer basic in-
browser editing for documents,
spreadsheets, slide shows, and
more, and users can collabo-
rate with others to tinker with
files in real time. The superb
feature sets SkyDrive and
Google Drive apart from their
competitors.

Giving others permission to
read or edit files is a snap in
both services, and each gives
you the ability to email direct
links to specific files. Sky-
Drive goes the extra mile and
includes a Public folder that
anybody can access, as well
as support for sending links
to over 30 social networks (but
not Google+).

Once you're actually collab-
oratively editing a document,
though, Google Docs presents
changesinrealtime, while Sky-
Drive’s Office Web Apps forces
all users to save and refresh
documents before showing oth-
ers’ edits. Google's approach is
vastly superior.

Winner: Winner: Winner:
Draw SkyDrive . Winner:
SkyDrive :
Google Drive
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down to the controversial Ribbon interface...

Round 5: File Protection

What if, in the midst of a hot-
and-heavy collaborative editing
session, a clueless co-worker
accidentally deletes an impor-
tant chunk of text and saves
the change? Fear not: Both
Google Drive and SkyDrive con-
tain handy-dandy version his-
tory tools that can restore files
to previous iterations. SkyDrive
tracks the last 25 versions of a
file, while Google Drive main-
tains file histories for 30 days
or up to 100 revisions.

The big difference lies in
what happens when you ac-
cidentally delete a file com-
pletely. In SkyDrive, deleted
files are simply gone, never to
be seen again. Google Drive,
however, moves deleted files
into a Trash folder, where you
can then choose to delete the
file permanently or restore it
to its original location, com-
plete with its version history
intact if it's a document.

Winner:
Google Drive

clients, on the other hand, look virtually identical.

And the
Winner Is...

Sigh. Ties satisfy no one, but individual needs really do determine which of these closely matched
cloud-based services is right for you. Google Drive, basically being Google Docs on steroids, holds
the slight edge in productivity tasks; SkyDrive is slightly cheaper, offers slightly more free stor-
age, and is available on more mobile platforms. Sign up for the service that supports your mobile
platform of choice, or heck, give ‘'em each a whirl if you're on the fence. Yay freemium! ()

SkyDrive
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Room for an SSD?

| have a 6-month-old Dell

XPS 8300. It came with one
2TB hard drive and | added

a second one for automatic
backups and some rarely used
data, pics, etc. While Windows
starts fine, as do apps, I'm
sure they would load even
fasterif | had an SSD, right?

Will my mobo accept an
SSD in addition to the two
HDDs and two optical drives?
There seems to be only one
free SATA port on my moth-
erboard since | added the
most recent hard drive. Can |
“splice” or use a SATA splitter
connector to get the SSD to
work, or do | need to add a
daughterboard for more SATA
ports?

Second, what's the best
approach for moving my oper-
ating system and apps to the
SSD? And third, what's a good
capacity? | have a 2TB HDD
that's about 10 percent full.

—Douglas R. Schafer

THE DOCTOR RESPONDS: You're
right, your Dell’s microATX
mobo has only four SATA
ports: two 6Gb/s SATA and
two 3Gb/s SATA. However,
the SATA spec does allow for
port multipliers. So if you
want to add an SSD, you can
buy a SATA port multiplier or
a PCle SATA card, or simply
unplug one of your existing
drives. The cheapest option,
of course, is to unplug one of

THIS MONTH THE DOCTOR TACKLES...

>
>
>

your optical drives. The next
least expensive, and the one
we recommend, is to buy a
PCle SATA card. You can get

a card that turns a spare x1
PCle port into two 6Gb/s SATA
ports for about $20.

Make sure your SSD is
plugged into one of the 6Gb/s
SATA ports on your mother-
board or the PCle card, so
you can take advantage of the
higher speeds of third-gen-
eration SATA. Use the 3Gb/s
SATA ports (SATA 2.0) for your
optical and backup drives.

We’'d say a good capacity
for an SSD is around the 240-
256GB range. Not only are
most modern SSD controllers
the fastest at that capac-
ity, but it gives you plenty of
wiggle room for your 0S and
most of your apps. Frankly,
we think the best way to move
everything over is just to
do a fresh install, but if you
want to keep your existing
structure, you can. First move
all your documents, movies,
pictures, music, etc. to your
backup drive—you want to
get the total amount of used
space on your C: drive as
small as possible. Aim for
less than half the capacity of
your SSD. Next, defrag the
drive. (Note: Once you put
your partition onto an SSD,
you should never defrag it, as
this isn’t good for the SSD.)
Then, use a partition manager
like Windows Disc Manage-

ment to shrink your C: parti-
tion down to the size of your
new SSD, and use Windows
Backup to create a system
image onto your backup drive.
While you're at it, create a
recovery disc using Windows
Backup.

Install your SSD into
your rig, then boot from the
Windows recovery disc and
restore from your system
image to the SSD. You should
be all set!

Upgrading to USB 3.0
| have a 2-year-old PC that
has an Asus P6T mobo and
a Cooler Master ATCS 840
case. If | upgrade my moth-
erboard, and that upgrade
includes USB 3.0, will the
ATCS 840 front-panel con-
nectors be able to use 3.07
Are they entirely dependent
on the mobo’s speed? Or do
they need to be upgraded,
too? (And if so, can you buy a
front-panel connection for an
ATCS 8407?)

—Dave Ruppel

THE DOCTOR RESPONDS: Dave,
USB 3.0 uses a different
internal header than USB 2.0,
so the ATCS's front-panel USB
2.0 ports won’t be able to use
the internal USB 3.0 header
on the new motherboard. The
bad news is that Cooler Mas-
ter doesn’t make a USB 3.0
upgrade cable for that case,
but the good news is that you

can get a 3.5-inch bay device
with two USB 3.0 ports on an
internal header for less than
$20. That way you can keep
your USB 2.0 ports and have a
couple of front-panel USB 3.0
ports, as well. We used one
from BioStar that cost us less
than $20.

One Card, Three
Monitors
I'm looking for a graphics
card to run three monitors
side by side. I'm a systems
administrator. | don't play vid-
eo games (I pretty much suck
at 'em). | occasionally edit
pics, run virtual machines,
and frequently use over 50
percent of my RAM. I'm using
a Dell Studio XPS with 12GB
of DDR3, WD Raptors in RAID
0, a Silent Pro 800W PSU, and
an Intel Core i7-975 Extreme.

| decided to add a third
monitor, since | usually have
a lot of windows open. I'm
looking for a card that will
increase my system perfor-
mance instead of slowing it
down. | tried using an Asus
HD 6670. That was a fail.
It made every single click
slower. My computer runs
like crap with this card and
three monitors. That's what
| get for trying to go cheap.
What's the Best of the Best
for this situation? If pos-
sible,  would like to keep it
under $300.

—Steve Culpepper

N

doctor@maximumpc.com
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THE DOCTOR RESPONDS: At
that price range, we would go
for an AMD Radeon HD 7850.
It will support up to six moni-
tors with AMD Eyefinity (al-
though for that configuration,
you’ll need to use DisplayPort
daisychaining). It's the best
card you can get for under
$300 that supports three
monitors, unless you can find
a Radeon HD 7870 on sale.

Core i7 Slowdown?
Doctor, | need help with my
PC!ltis running at 1.6GHz
when it's supposed to be
running at 3.4GHz. My CPU is
a factory-overclocked Core
i7-2600K. I've tried to fix it
through my BIOS, but that
didn’'t work. Help!

—Geva

THE DOCTOR RESPONDS: Your
CPU is designed torun at a
lower clock speed whenit’s
not being used. Download
TMonitor from CPUID.com and
run it. If you're not doing any-
thing else with your computer,
you should see that the clock
speed is around 1.6GHz. But

if you do something that actu-
ally utilizes the CPU (like run
Prime95 or another bench-
mark), you'll see the clock
speed go up to 3.4GHz on as
many cores as you're using.

Relief for Sore Eyes
In Windows Vista and previous
versions, | have always been

able to adjust the width of
the scroll bars. Many of the
people | provide tech support
to are baby boomers and
they have a hard time using
the scroll bars on the default
setting. | used to be able to go
through Display Options and
set them manually to about
22 pixels. | would also adjust
the size of the font up to 12
or 14 on the desktop icons
and sometimes the icons
themselves up as much as 44
pixels. | do this for them so
they don’t lose the resolu-
tion for watching movies and
other media by changing the
entire screen resolution. But
now with Windows 7 | swear
| just cannot find any way to
doit. If  knew where to look
in the Registry | would go in
and change the default so
users could not knock it out of
whack if they go on an explor-
ing expedition.

—~Carl Smith

THE DOCTOR RESPONDS:
Microsoft buried this option
in Windows 7, but it’s still
there. Right-click the desktop
and select Personalize, then
Window Color, then hit Ad-
vanced Appearance Settings.
This will open the Window
Color and Appearance dialog.
Under the Item drop-down
menu, scroll to Scrollbar. You
can then adjust the width of
the scroll bar in pixels (the
default is 17).

o

Change the color of your window borders, Start menu, and taskbar

You can adjust the size of many Windows features in the Windows

Color and Experience dialog.

To change the text size, go to
Control Panel > Appearance
and Personalization, and
under Display select “Make
text and other items larger
or smaller.” This will give
you basic small/medium/
large controls; to fine-tune
settings, look in the left-hand
menu for “Set custom text
size (DPI).”

SSD Alignment
Back in November 2011 |
purchased a 64GB Crucial M4
SSD so | could use it as cache
for my hard drive via Intel’s
Smart Response Technology.
| took the SSD out of the box,
updated the firmware and set
it up through the Intel Rapid
Storage Technology interface,
and have been running with it
ever since. | was wondering if
I needed to have formatted/
aligned the SSD before using
it for caching? Have | been
cutting my SSD’s lifespan by
not formatting/aligning it? Is
formatting/aligning only par-
ticular to using it as a regular
storage device or boot drive?
There have been no prob-
lems with IRST. | have seen
improvements in program
response as well as faster
boots and shutdowns.
—Joeseth Perez

THE DOCTOR RESPONDS: If
you're just using it for cach-
ing, IRST (which handles
SRT—why did Intel use such
similar initialisms?) should
handle all that stuff for you.
Aligning is only an issue if
you're using Windows XP,
as Vista and 7 automatically
align SSDs correctly, and if
you're just using the drive
for caching you don’t need to
worry about formatting, as
SRT takes care of all that.

Upgrade, Then Sell?
I'm planning on building a
new computer. My current
computer has a liquid-cooled
3.2GHz quad-core Phe-
nom, an Asus M4A88TD-M
motherboard, a 1GB Radeon
HD 5770 videocard, 16GB
DDR3/1333, and a 1.5TB hard
drive. Should | putin a new
CPU (such as an FX-8150)

and overclock that and the
RAM before | sell it, or just
sell as-is?

With the money, | plan
on building a new PC with a
Core i7-3820, a 3GB Radeon
HD 7970 Black Edition, 32GB
DDR3, a 256GB Samsung
SSD, and an Asus Rampage
Extreme motherboard. Or
should | wait for lvy Bridge-E
to come out?

—Cody

THE DOCTOR RESPONDS:
There’s no pointin spend-
ing money on a new CPU for
a computer you're trying

to sell. Let whomever buys

it upgrade it if they want.
And obviously you're going

to have to supplement your
earnings from selling your
PC if you want to upgrade

to arig as fancy as the one
you describe. As for whether
to build now or wait for vy
Bridge-E, well, PC hard-
ware is always going to be
faster and cheaper later. To
help you make your decision
though, a Sandy Bridge-E
Core i7-3820 is a serious step
over a Phenom Il in compute-
intensive tasks, so it will feel
noticeably different. Rumors
point to Ivy Bridge-E not
making an appearance until
early next year. 0

[SECOND OPINION]

| was just reading your
response to Anderson Wu
about swapping mother-
boards without reload-
ing  Windows (“Getting
Ready for the Move,”
June 2012) and | thought
| should chime in. Stor-
ageCraft makes a prod-
uct called ShadowPro-
tect Desktop Home ($90,
www.storagecraft.com)
that does a great job at
image-based backups and
has a little-known feature
called Hardware Inde-
pendent Restore. It actu-
ally strips the drivers away
from the source backup
image, allowing you to re-
store a working OS to com-
pletely new hardware.
—Eric Schueler
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CLEAN UP YOUR HARD

DRIVE
Over time your PC will become clogged
with unwanted files, and this will
cause it to get slower. Just like a race
car that's full of unwanted junk, clear-
ing out the rubbish will make a huge
difference.

The first thing you can do is go to
Start > Accessories > System Tools
and go to Disk Cleanup. This checks
your PC for unwanted temporary files,
which are left behind after programs
are installed, as well as your Recycle
Bin and other common clutter bugs.
It will give an estimate of how much
waste you can eliminate. Just click OK
to begin the cleanup.

If your PC is really full, you might
need a more powerful clutter cutter.

AutoHotKey (free, www.autohotkey.com)
is a powerful tool for automating repeti-
tive tasks. Download and install it, then
right-click your Desktop or inside any
folder and select New > AutoHotKey

script. Right-click the resulting .ahk file
to edit it. Hope you like plaintext!

AutoHotKey lets you create key-
board shortcuts, text expansion snip-
pets, and macros, but it has a steep
learning curve—fortunately a robust
tutorial takes you from #space::run

CCleaner is a heavy-duty software un-
installer that goes a lot deeper than the
system tools. It's available (for free!)
at www.piriform.com. Install the pro-
gram and enable the option to smartly
detect cookies to keep. When the pro-
gram opens, click the Analyze button to
see how much clutter is present—you
might be in for a surprise.

When you're ready, just click Run
Cleaner and watch as CCleaner trims
the fat from your computer, leaving it
leaner and faster. Run the program
every month and your PC will be less
susceptible to slowing down over time.
There are other free programs that
can declutter your system. We've list-
ed five that we like on page 28. They
can make areal difference in the speed
of your PC.

www.maximumpc.com (which sets Win
+ Space to launch MaximumPC.com in
a browser window) to complex condi-
tionals and macro recording.

AutoHotKey's scripting language is
powerful—you can use text expansion
to save you typing time, or do some-
thing as complex as using one button
to screencap, import to Photoshop,
crop, and save. It may take a while to
script, but the results will save you
lots of time. Check out Maximum PC’s
2010 How To for more! bit.ly/LKgU1d

STREAMLINE YOUR PC

PCs take a lot of abuse, and folks
who like to try new software will often
leave lots of unwanted applications on
their PCs. Removing these is a quick,
easy fix that will speed up your PC.

To begin, click Start > Control Pan-
el, then select Uninstall a Program. If
you have Windows Vista or Windows
7, then right-click the Name column
header, click More, and choose the
details you'd like to see about each
program. We recommend checking
the Name, Size, Installed On, and Last
Used On boxes.

Now choose to sort by Date Last
Used, and you’'ll see your applications
sorted by when they were last run.

If you have programs that haven’t
been used in months, then try get-
ting rid of them, or switching to a free
download that can be installed when
and where you need it. Many programs
are now available in the cloud. This
means that there's next to no footprint
on your PC, and the bulk of storage is
contained online. There are cloud ver-
sions of Photoshop, Office Word, Excel,
and OneNote, which offer stripped-
down functionality.

You can also click “Turn Windows
features on or off” or "Add/ Remove
Windows Computers” to remove Win-
dows applets you're not using, but this
generally has less effect. If you never
run an applet then it won’t slow you
down and turning a feature off won't
free up much, if any, disk space, either.
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Select which icons and notifications appear on the taskbar

If you cheose to hide icons and netifications, you won't be notified about changes or updates. To view hidden icons at any time,

click the arrow next to the notification area on the taskbar.

@ Micresoft Outlook
Microsoft Outlook

ﬂ:ﬁ Action Center
Solve PC issues: 3 messages

2 Network

Unidentified network No network access future...

4% SUPERAntiSpyware Application
SUPERAntiSpyware 5.0.1144 Core: 7882 Trace: ...

{3 Dropbox
Dropbox 1.2.52 All files up to date

Behaviors

Show icen and notifications b

n and notifications
Hide icon and notifications
Only show notifications

[smw icon and notifications \d ]

[Show icon and notifications -

Turn system icons on or off
Restore default icon behaviors

Always show all icons and notifications on the taskbar

MANAGE YOUR SERVICES

Services are programs designed
to work silently in the background
on behalf of both Windows and some
third-party applications. They're load-
ed before the Welcome screen appears
and run regardless of which user is
logged on.

Services cover a wide range of uses
and, depending on your computer, not
all will be needed. For example, the
Windows Update service is essential
because it monitors and downloads
updates for Windows, but the Blue-
tooth Support service is only relevant
if you have a Bluetooth adaptor in-
stalled in your PC.

Having these services running can
be a real drain on your PC’'s perfor-
mance, but with some nifty tools you
can get them under control. One such
tool is SMART (bit.ly/dosSJj), which
takes a lot of the risk out of canceling
services by telling you which ones are
safe to stop.

Applications | Processes | Services | Performance | Networking | Users |

Name PID  Descpton  Status | Group
Vaultsve Credential ... Stop...

Samss 572 SearityAc.. Runn...
ProtectedStorage Protected ... Stop...
NetTepPortsharing NEtTPO...  Stop...

Netiogon Netiogon Stop...

Keylso 572 CNGKeyls.. Runn...

idsve Windows C...  Stop...

EFS Encrypting ... Stop...

AxInstsV ActiveXIns... Stop... Axinsts
bhserv Bluetooth ...  Stop...  bthsves
Power 692 Power Rumn...  DeomLaun|
PlugPlay 692 PugandPlay Runn... Deomlaun|
DeomLaunch 692 DCOMSer... Runn... DeomLaur|
WinHttpAutoProxySvc 125 WinHTTP...  Runn... LocalServi
WebClient WebClient  Stop...  LecalServi
WiServiceHost 125 Diagnostic... Runn... LocalServi
W32Time WindowsTi... Stop... LocalServi
THREADORDER ThreadCr...  Stop... LocalServi
SstpSve SecureSoc.. Stop...  LocalServi
sppuinotify SPPNotific...  Stop...  Localservi
nsi 1255 MetworkSt... Runn... LocalServi
netprofm 125 Metworkli.. Runn... LocalServi
Iitdsve. Link-Layer ... Stop... LocalServi
fdPHnst 17548 Functinn Di Runn. | acalServi

TAKE CONTROL OF YOUR

SYSTEM TRAY
Perhaps you've wondered about that
odd assortment of icons that lives at
the far right of your taskbar, in the
area commonly known as the system
tray or notification area. It's a visual
cue of what programs are running in
the background, with the notifications
letting you know about changes or
updates to a program. You can take
full control of the system tray so that
it contains the information that's most
useful to you, thus increasing your
efficiency.

To customize the system tray,
right-click the taskbar, select Prop-
erties, and then click the Customize
button in the middle of the screen.
Now, for each program decide how
and when you want the icon and
notifications to be displayed. You can
also rearrange which icons appear on
the taskbar itself and which ones are
only visible when you click the system
tray arrow. Just drag and drop to your
liking.

ENABLE PREVIEW PANE

You can save a lot of time by en-
abling the preview pane in Windows
Explorer. It lets you see the contents
of any file without having to actually
open the file. Open Windows Explorer
(explorer.exe], select Organize, and
then Layout. Select Preview pane
from the menu. Now, when you click
on any file in Explorer you will in-
stantly see its contents in the preview
area to the right. You can adjust the
size of the preview area by dragging
its left-hand border.

When it comes to saving time, the
taskbar is a very powerful tool

To select a taskbar app from
the keyboard, hold the Windows
key and press one of the numbers
across the top of your keyboard.
Press 1 to launch the first icon, 2
for the second, 3 for the third, and
soonuptoO (that represents 10J, so
you can have items openin seconds.

To quickly switch between win-
dows of the same application, hold
down the Ctrl key as you click the
app’s taskbar icon. This is great for
when you have multiple instances
of Internet Explorer with different
websites, or when you're working
with photos and images.

To switch to a taskbar ap-
plication from the keyboard, hold
down the Windows key and press T
to select the taskbar, then use the
left and right arrows to select an
application and the Return key to
launch it. This can be easier than
remembering numbers.

If you've launched an application
and then want to run another copy,
don’t go back to the Start menu—
just hold down Shift, click the app’s
taskbar icon and Windows fires up
another instance of the program.
Again, this works especially well
for browsing.

If you work with multiple
windows, such as several tabsin |IE,
finding them can be a drag. In Win-
dows 7, just click the program icon
on the taskbar to get live preview
windows of every tab or window.
This makes it easy to go straight
to where you need to be.
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Change settings for the plan: High performance
Choose the sleep and display settings that you want your computer to use. Control Panel > Hardware and Sound
c > Power Options, and ensure you have
u SR 4 Puggedin High Performance selected. Alternatively,
© Dim the display: Iwmimu@ T] [4miw 'I if your computer is being too demanding
' — — on your laptop’s battery, then you can go
i e [ominutes 2 [oow = into a low power mode, but this will slow
Windows down.
O Put the computer to sleep: l30 minutes Y] [1hour Vl
SET YOUR PC TO BOOT
o Adusplanbignness 0 U@ @ 0w 1 7WITH GREATER SPEED
If you've installed multiple versions of Win-
dows on your computer, you'll get a menu
Change advanced power settings asking which version you'd like to launch.
T By default this waits up to 30 seconds before
selecting the default choice, but if that's too
‘ S | [ — ] long, launch msconfig from the Start menu,
clickthe Boot tab, and set the Timeout figure

to, say, 10 seconds instead.

button option. Right-click Start, choose

Properties, and under the Start Menu tab, SIS, 20 M
select the power button action that you

HALT RUNAWAY PROGRAMS
If a buggy program is grabbing all

1

your processor time, slowing everything File Options View Help
. . use most frequently.
else down, and you can't close it, press | Processes | services [ performance | [ Users
Ctrl + Shift + Esc to launch Task Manager. = .
Click Processes, then select “Show pro- 1 VISUALIZE YOUR STORAGE ‘Lcmagemm Lcer e JiCERY) vemory (- z:;”::" I
cesses from all users.” Click the CPU col- SITUATION conhostexd  OPen FileLocation Console .. |2
umn header and find the program using the There's no better way to see what you're :;g;sme End Process :T’IEM
most CPU time. Right-click the program,  storing on your hard drive and whether vl End Process Tree P
select Set Affinity, clear all but one of your it's earning its keep than by using a visual- taskmar.exg Debug Windows ...
F H H H H H conhost.exg = s Consale ...
processor core boxes to limit how much of izer. One of our favorites is WinDirStat (free, s UAC Virtualizstion o
your system resources it can use. Your PC www.windirstat.info). On startup it creates FMsiscane,  CreateDumpfFile Futurema..
will speed up. a rectangular treemap of all your folders Isj‘G‘”"I;m"& Set Priority ’ ii‘r’”}:’"
and files, color-coded by file type. With the o e Set Affinity... e
CUSTOMIZE THE POWER graphica evidence before you, you can eas- | properts et
BUTTON ily determine what stays and what goes. conhost.exd Go to Service(s) Consdle .. o
If you find that you typically restart your [ ) show processes from al users | End Process
PC more often than you shut down, you 1 USE HIGH-PERFORMANCE
can save yourself the cumulative nano- MODE brocesses 95 CPUUsaqe:100%  Physical Memorv: 30% |

seconds incurred every time you have to
select Restart by making that the default

The Windows 7 Power Options can make
a real difference to system speed. Go to

We mentioned
the awesome cleaning
power of CCleaner (see
tip #2), but it has other
powers, too. Try using
the Registry Cleaner,
which spring cleans the
back end of Windows
for faster performance.
bit.ly/8XAvD9

Another piece of
cleaning software that
gets rid of leftover files,
Glary can also securely
uninstall programs,
which is a notoriously
messy experience when
done in Windows.
www.glarysoft.com

This free program will
stagger your startup
apps, which stops
Windows from grinding
to a halt. To learn more
about how to put Startup
Delayer to use, see our
How To on page 56.
WWW.r2.com.au

If you regularly
read PDFs, you probably
get frustrated by Adobe
Reader’s lumbering lack
of speed. Foxit Reader
speeds things up, making
viewing PDFs quick and
easy. It also uses very
little of your computer’s
memory. bit.ly/KvjPZb

seccessecsssesecsesscsesscsesscsesscsenne

Windows' na-
tive search functional-
ity has improved greatly
over the years, but if
you want a truly speedy
search of your PC's
contents, you need the
free file-indexing app
Everything.
www.voidtools.com
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2 DELETE DUPLICATE [N

MUSIC IN ITUNES
It's an unfortunate fact about
iTunes on Windows that it will
sometimes store duplicate tracks
of the same song.

Luckily, iTunes includes a tool
that finds, identifies, and removes
duplicates, keeping your music
collection trim and, more impor-
tantly, your computer lean.

In iTunes, go to File > Display
Exact Duplicates and a list of all
repeated songs will be displayed.
It would be a lot easier if iTunes
only showed the duplicate ones,
but unfortunately it displays both,
so you'll have to tick the second
version and hit Delete.
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2 REMOVE OLD PICTURES

When you edit a photograph
in Windows Live Photo Gallery, it keeps a
copy of the original forever. That's great if
you've actually made the new pic look aw-
ful or want to keep the original, but other-
wise it's a waste of space. To tweak this,
launch Photo Gallery, click File > Options
> Originals, and under “Move originals to
Recycle Bin after” select one month—or
longer if you prefer.

2 SAVE RESOURCES

If you've installed an antivirus
package, it's a waste of resources to have
Windows Defender running as well, since
you essentially have two programs doing
the same tasks. To turn off Defender, click
Start, type Defender and click Windows
Defender to fire up the program. Click
Tools > Options > Administrator, clear the
Use This Program box, and then click Save.

Corts fane! Ho Change the visuals and sounds on y{
Change desitop wans Click a theme to change the deskiop backgrour|
Change motse poiters T
3 United Kingdom

Change your account picture

Irtalled Theemes (1}

e

Detl

Basc and High Contrast Themes ()
i Desinop Background
Display Harmony

2 SPOT HIDDEN WINDOWS

Sometimes programs display a
message asking you to do something, but
that message is under another window and
you don't see it. You're waiting for the pro-
gram, it's waiting for you, so nothing hap-
pens. The window is made visible after 200
seconds, but you can shorten the delay.
Launch regedit from the Start menu, go
to HKEY_CURRENT_USER\Control Panel\
Desktop, double-click ForegroundLock-
Timeout and select Decimal. Change the
value to 30,000 milliseconds (30 seconds)
and see how this works.

2 SAVE A REGISTRY KEY
Sometimes a change to a regis-
try key doesn’'t go as planned. It's quick
and easy to return to the key you changed
if you've saved it to Regedit's Favorites
menu. It's at the top of Regedit's editing
window. Click Add to Favorites, give it a
descriptive name, and tweak away know-
ing that changes can be undone in seconds.

2 DISABLE AERO
If you're running Windows 7 on
an underpowered computer, improve per-
formance a little by turning off the Aero
interface. Right-click an empty part of
the desktop, select Personalize, scroll
to Basic and High Contrast Themes and
click Windows 7 Basic. If you miss the old
look, return to the Personalize dialog and
choose an Aero Theme.
Alternately, you can disable Aero for just
a particular program—say, something that
could use a little extra RAM. Browse to the
program’s executable file or its shortcut,
right-click it, select Properties > Compatibil-
ity and check “Disable desktop composition.”
Run the program and Aero is turned off.
It's restored when the program is shut down.

Windows offers many tricks to
help you work more efficiently

Hold down the Windows
key, press R to launch the Run
box, type . and hit Return.

Launch the Run box, type .. and
press Return to launch the Users
folder.

To open your Startup
folder, for example, click Start,
type shell:startup and press
Return.

When you want to search
for something in an Explorer
window, just press F3.

Press F4 and you can
choose recent folders from the
History list much more quickly.

If an Explorer window
seems to be missing a file, folder,
or drive, hit F5 to refresh the
window.

If you're examining an
enormous list press F11 to toggle
full-screen view.

Press + on the numeric
keypad to expand the currently
selected folder.

Pressing * on the nu-
meric keypad expands all folders
below the current one.

Press - on the numeric
keypad to collapse the current folder.
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3 COPY AS PATH

If you've ever found yourself hunt-
ing down a file in Explorer that you want to
upload online only to have to retrace your
steps once you've opened your browser,
you need to know about Copy as Path.
When you first locate the file in ques-
tion, press Shift while right-clicking and
choose the Copy as Path option. Now the
location of your file is saved to the clip-
board for easy deployment in your brows-
er dialog.

4OBROWSE MENUS AT
SPEED

A registry edit can shorten the pause
before Windows menus expand, speed-
ing up navigation. Launch regedit from
the Start menu, go to HKEY_CURRENT_

Programs (1)
e

Files (1) 0
Windows tips 38-70v2

Windows 7 keeps files on your last 50
crashes. However, if you'll never look at
this data it's a waste of hard drive space,
so you're better off getting rid of it. Type
regedit into the Start menu and launch
the executable.

USER\Control Panel\Desktop, double-click
MenuShowDelay, and select Decimal.
Change the default—200, which is 0.2 sec-
onds, works for us. The result is a notice-
ably more instant browsing experience,
which is highly addictive. Once you've en-
joyed Windows opening like lightning, go-
ing back to the normal setting will feel like
watching a slow-motion replay.

4 SOLVE SLOW STARTS

If Windows 7 is taking a long time
to launch, or shut down, the Event Viewer
may tell you which program or driveris re-
sponsible. Click Start, type Eventvwr.msc,
and press Return. Expand the Applications
and Services Logs section and browse
to  Microsoft\Windows\Diagnostic Perfor-
mance\Operational. Scroll the events list

onyour PC to see if Windows knows who to
blame for your performance issues.

4 FIX THE BOOT BUG

Is your Windows 7 desktop back-
ground a solid color? Then it may mean
your PC takes 30 seconds longer than usual
to boot. One solution is to change your
background to an image, which will restore
normal startup performance and make your
desktop look better, as well. But if you're set
on solid colors, then install a hotfix from Mi-
crosoft (support.microsoft.com/kb/977346)
that will return your system to normal.

438EARCH THE WEB FROM
YOUR START MENU
Windows 7 Professional and Ultimate us-
ers are able to set up the Start Search op-
tion to search the web. In Start Search type
gpedit and open the app. Then navigate to
User Configuration > Administrative Tem-
plates > Start Menu and Taskbar. Then
double-click “Add Search Internet link to
Start Menu.” When you type a search into
the Start menu, there will be the option
to make it a web search, so you can more
quickly get the information you need.

ew @ EE

Browse to HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Control\
CrashControl. Double-click the entry
called MiniDumpsCount and change the
Value data according to how many crash
files you want saved—five is enough.

Type Data
"oz {robo nct et}

; G EWORD tnomoeee )
H Crahbumplna. HS_DWSRD 0Rees (1)

When you restart your PC, you’ll
have reclaimed some free space on your
hard drive, which is useful for both old-
er machines with small hard drives or
newer SSD laptops, which have equally
tiny disks.
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4 RESTORE RUN

If you miss the Windows
XP Run option, which was used by
many to launch programs quickly,
right-click the Start orb, select
Properties > Customize, check the
Run Command box, click OK, and
a Run option now appears on the
Start menu. Many of our tips fea-
ture the Run command and if you
love sneaky shortcuts, this is a
very easy way to start using Win-
dows more quickly.

4B kpriers rast

Don’t waste time browsing to the

Files (1)
] WLT159_Rev3_Lenovol3005

Control Panel for the right tool for

lp See more results I

making changes to your computer

when you can launch it directly.

| contentlevieuﬂ X | [Shl.l‘ldmm\ | 3 ]

To run Device Manager, for exam-
ple, click Start, type Device in the
search box and Windows should display
a Device Manager link for you. Windows
also responds to vague searches, so if you
type partition, the disk management tool
will be listed.

You can also type the applet’s executable
file name, such as: devmgmt.msc (Device
Manager), services.msc (Services), dfrg.msc
(Disk Defragmenter), compmgmt.msc (Com-
puter Management), diskmgmt.msc (Disk
Management), and compmgmt.msc (Com-
puter Management Console).

47OPEN WEBSITES

WITH A KEYPRESS

In Internet Explorer, click Favorites, right-
click a particular Favorite site, and select
Properties. In the Shortcut Key box, press
the key combination you'd like to launch
the site—Ctrl + Alt + G for Google, say.
Close your browser, press your shortcut
key, and your default browser opens to
display the site. This also works for any
Windows programs.

Control Panel (30)
ﬁ Devices and Printers
| £ Device Manager

& View deviced poice Manager
ﬁ Change devi| View and update your hardware's settings and driy

Documents (12)

htc pure review_2ws
Microsoft Outlook (1887)
(=1 FW: News: next-gen Chromebock and Chromebox announced

(=3 News: next-gen Chromebook and Chromebox announced
(= Article suggestion
(1 Your July 2012 digital issue of What Laptop is here!
Files (34)
|- Adobe Device Central C55
resume 11131 220
resume_11102_220

7 See more results

4 ACCESS NETWORK
FILES FASTER

To work on network files even when your
PC isn’t connected (in Windows 7 Profes-
sional, Ultimate, or Enterprise) there's an
easy fix. When the network computer is
available, browse to the file or folder you
need, right-click it, select Always Avail-
able Offline so that it's checked and Win-
dows makes a local copy available for you.

4 FIND THE RIGHT FILE

If you occasionally need to search
the contents of files that haven’'t been in-
dexed, just start your search with content:.
This will tell Windows to go looking inside
your files for the right information, even if
Windows Search hasn’t gone through and
done it already. As this happens only a
couple of times a day, new files might not
be indexed, so it's well worth doing. Typing
content:zebra into any search box locates
files that have “zebra” in their contents, for
instance.

5 SAVE TIME ON SWAPPING
PRINTERS

To have Windows switch your default
printer as you change networks, click
Start, type Devices, and click Devices
and Printers. Choose a printer and click
Manage Default Printers. Select “Change
my default printer when | change net-
works,” choose a network and a default
printer, and click Add. Repeat for other
networks and pick a default printer. Now
when you connect to a network, Windows
will set a defined printer.

The Windows key has many
uses. Here are just a few...

Dock the current window left

Dock the current window right

Maximize the current window

Minimize the current window

Minimize all windows

Maximize windows

Make all windows transparent

Lock your desktop

Move the focus to system tray

Launch My Computer tray

Open the Find dialog

Open the Find Computer dialog

Display System Properties

Zoom in on the screen

Zoom out from the screen

Open Ease of Access Center

Cycle through taskbar items

Cycle through open windows

Open the Run command

Lock your Windows PC

Open the Help folder

[ devid % || Shutdown | » |
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74SCALE BACK
VISUAL EFFECTS

Right-click the Start button and select
Properties. Click Customize, scroll down
the list of available options, and select
“Search without public folders” under
“Search other files and libraries.” Click
OK and results should appear much
quickerthan before, as there are far fewer
places to search. Public folders are rarely
used by most people, so axing them in
search is a cost-free speed up trick.

7 LOAD WEBSITES

MORE QUICKLY
By changing your DNS server to
OpenDNS, you're able to browse the
Internet more quickly and safely. Visit
www.opendns.com/start to sign up for a
free basic plan.

Pinned

Recent

#] Review Testang Process

Windows tips 71-100 ﬁ |

] WLT159_Rev3 Lenovol3005

If you don’t have a lot of memory installed
(1GB in Windows 7 or Windows Vista, or
256MB in Windows XP), click Start, right-
click Computer or My Computer, and se-
lect Properties. Select "Advanced system
settings” (Advanced tab in Windows XP)
and under Performance click Settings.
Select “Adjust for best performance” and
click OK to give yourself a speed boost.

7 QUICKLY ACCESS THE
COMMAND PROMPT

Did you know that you can open the com-
mand prompt from any folder? Press the
Shift key while right-clicking the folder
and then choose the option to "Open com-
mand window here.” This trick also works
on the desktop.

7 GIVE YOUR PC A HELPING
HAND

If you have a spare USB flash drive, you
may be able to use it to give your PC a
small boost. Plug the drive in and—if
prompted—choose “Speed up my sys-
tem.” Otherwise, click Start > Computer,
right-click your flash drive and choose
Properties, then choose “Use this device
to enable ReadyBoost.” Mind you, this
likely won'timprove performance on a 64-
bit install of Windows, but if you're rock-
ing a 32-bit version of the 0S you should
check it out.

77MAKE YOUR PC

AS GOOD AS NEW

Get that shop-fresh feeling back by re-
installing Windows using the disc that
came with your PC. When you're done, go
to Start > Search, type Back up and Re-
store and set a restore point, so you can
roll back to this clean setup in the future,
bypassing the installation process.

78MANAGE

YOUR FONTS

Over time, the number of fonts installed on
your PC swells and each one uses up pre-
cious systemresources. Use a program such
as AMP Font Viewer (www.ampsoft.net) to
remove those fonts you never use. Windows
Vista and Windows 7 users should right-click
the program shortcut, choose Properties >
Compatibility and tick “Run this program as
an administrator” for it to run properly.

] TR Lencwali3005 review
[H] STANDARD LAPTOR REVEE...
8| Wele nermllio surmecd

To open a Jump List,
simply right-click

a program icon on your
taskbar to see a list of
recently opened files
associated with that
application. It's quicker
to launch a file from
here than from the
file’s location.

Review Testing Process
TR_Lenovol3005 review

Only the 10 most re-
cent items are shown,
but you can “pin” your
favorite items to a
Jump List so they're
shown permanently.
Click the pin to have
them locked and click
it again to unpin.

Gececsesecscsecsesecsesecsesscsesscsesecsessesessesessessns

You can add more
recent items by right-
clicking the taskbar,
selecting Properties,
and then going to the
Start menu tab. At the
bottom you can adjust
the number of recent
items to display.

sites you browse regu-
[ENACROGEREEETS
enabling you to launch
them quickly. In your
browser, just click the
icon next to the URL
and drag it down to the
taskbar to add it.

Gececsesecscsecsesecsesecsesscsesscsesecsessesessesessessns

If you use Internet Ex-
plorer 9, some websites
have added functional-
ity and are quicker to
use when pinned. Try
dragging Twitter or
Facebook to the taskbar
from Internet Explorer
9, and you'll see the dif-
ference.

32 | e

AUG 2012



8 CHECK DEFRAG

One of the oldest tricks for speed-
ing up a PC's performance is hard drive
defragmentation. Applicable only to me-
chanical drives (as opposed to SSDs), de-
fragging takes all the various fragments
of data that get scattered across hard
disks over time and puts them in nice or-
der so the drive doesn’t have to work as
hard at data retrieval. With Vista and Win7,
defrags should happen automatically. To
ensure that defragmentation is enabled
on your hard drive (and not enabled on
your SSDJ, right-click your drive's icon in
Explorer, select Properties, then Tools,
and click the Defragment Now button. Be-
sides verifying the defrag status, you can
select a schedule that will have the least
impact on your computing activities.

8 TWEAK LIBRARY SETTINGS

Edit an existing Library or create
a new one by clicking Start > Computer
followed by Libraries in the Navigation
pane. Click New Library or right-click an
existing Library and choose Properties to
include new folders in the library or re-
move existing ones.

8 SET UP YOUR
FAVORITE FOLDERS

If you want even quicker access to specific
folders—again from any folder window or
when choosing Open or Save in a program
—just browse to the drive or directory
containing your target folder, then click
and drag it into place on the Navigation
pane under Favorites.

8 ADD PROGRAMS TO
FAVORITES LIST

It's also possible to add programs to

Explorer's Favorites list, although the

process is a bit different. Open Windows

Explorer and type C:\Users\[user name]\

Links in the address bar (replacing [user

name] with your user account name).
Now drag and drop program shortcuts
from the Start menu, desktop, or other
location into the Links folder. Those
program links will now appear in your
Favorites list.

88USE THE 'SEND

TO' FOLDER

There are a number of useful shortcuts
available to any file or folder, simply by
right-clicking it and choosing Send To.
You can open a file in a specific program,
compress itintoazipped folderin order to
save space, and create desktop shortcuts.
And that's just for starters.

8 9INVERT
SELECTION

If you need to select a large group of
nonconsecutive files within a folder, it's
quicker to select the files you don’t need
before choosing Edit > Invert Selection. If
you can't find this at first, don't worry—the
Edit menu is hidden by default in Windows
7 and Windows Vista. Choose Organize >
Folder and Search Options > View, then
tick “Always show menus” and click OK to
show it.

9 SPEED UP INTERNET
EXPLORER

If Internet Explorer takes an age to open,
select Tools > Internet Options > Programs.
Click “Manage add-ons” and view the Load
Times for each add-on (you may need to
scroll to the right to view this). Add-ons
cause Internet Explorer to run more slowly,
so have a go at disabling sluggish add-ons
unless theyre important, such as those
linked to your security program.

This isn't a problem that’s confined to
Internet Explorer. Firefox is renowned for its
array of add-ons. If you've added applets that
you're not using, slash them and enjoy the
feeling of a more responsive browser.

E Google Chrome @ Zune
I} Desktop
(A Libraries
@ Documents
J' Music
[E=] Pictures
l‘i” Podcasts

I Videos

Crganize = Include in library = Share with = Burn Mew folder
P Favorites = MName . Date modified Type Size
B Desktop El [7H Desktop 2/27/20129:54 AM  Shortcut 1
i Downloads | 2 Downloads 2/27/20129:54 AM  Shortcut 1
42 Dropbox [ Dropbox 9/22/2011 10:56 AM  Shortcut 1
2 Recent Places (& Google Chrome 5/29/20121:22PM  Shortcut 3
. Maxpc Edit @ Maxpc Edit 5/9/201211:09 AM  Shortcut 1
. Maxpe Phote @ Maxpc Photo 5/9/201211:09 AM  Shortcut 1
@ Zune [iﬂ Recent Places 2/27/2012 9:54 AM  Shortcut 1
1

5/29/2012 1:21 PM Shortcut

Make Windows' web services
work faster for you, too

i— P =
MAXIMUM

Selects the text in the Address bar

Displays a list of addresses you
have typed

When in the Address bar, move
the cursor left to the next logical break in
the address (period or slash)

When in the Address bar, move
the cursor right to the next logical break in
the address (period or slash)

Add www. to the beginning and
.com to the end of the text typed in the
Address bar

Delete browsing history.

Open an InPrivate Browsing
window

Open a new tab

Switch to a specific tab number

Return to your home page
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BY NATHAN EDWARDS

IS NVIDIA'S GTX 690 A DUAL-GPU
CARD WORTH BUYING?

IT'S BIG. It's beautiful. It costs one thousand dollars. Nvidia took
two of its fastest Kepler GPUs and put them on the same dual-slot
videocard. The resulting behemoth, dubbed the GTX 690, begs for
attention. But the last generation of AMD and Nvidia dual-GPU cards
was hot, loud, and disappointing. Does the GTX 690 carry on that

ignoble tradition, or is it as good as it looks?

| AUG 2012




Magnesium alloy. Chromium-plated
aluminum. Polycarbonate windows.
This ain’t your typical reference card.
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GTX 690 =

Getting the
Outside Right

The graphics card goes inside
your computer and makes the
stuff that comes out of your
computer look good. It doesn't
matter what the graphics card
looks like on the outside [so
long as it has, say, heatsinks
and a fan shroud], just how
powerful it is on the inside, and
Nvidia and AMD’s reference
cards are usually reflections of
this boring truism. In the battle
for differentiation, though,
third-party card vendors go to
town, with custom fan shrouds
and cooling systems that
alternate between garish and
gorgeous.

It'd be hard for any after-
market vendor to improve on
Nvidia’'s GTX 690 reference
design, however. It's not just
the prettiest reference card
we've ever seen; it may be the
most beautiful videocard we've
seen, period.

The GTX 690 is a dual-GPU
graphics card that's 11 inches
long—big for an Nvidia card, but
far smaller than the 12.2-inch

WHITHER BIG KEPLER?

The GPU in the GTX 680 and 690
is designated GK104, and the
“104"-designated GPUs aren't
usually the biggest, most power-
ful of their generation. The Fermi
GF104, for example, powered the
GeForce GTX 460, a midrange

card, while the later GF110 (a

smaller, more power-efficient
version of the GF100) is the GPU
in the GTX 580. So where’s the
GK110, and what sort of video-
cards will it power?

Nvidia dropped some info on
the GK110 at this year’s GPU Tech-
nology Conference. What do we
know? Well, it's not for us. Yet.

IT'S CLEAR THAT NVIDIA SPENT SERIOUS
TIME WORKING ON THE REFERENCE SHROUD

SPECIFICATIONS

GeForce GTX 690 GeForce GTX 680 Radeon HD 7970 GeForce GTX 590

Number of Cores 3,072* 1,536* 2,048* 1,024*

Texture Units 256 128 128 128

ROPs 64 32 32 96

Base Clock Frequency 915MHz 1,006MHz 1,000MHz 607MHz

Boost Clock 1,019MHz 1,058MHz N/A N/A

Frequency

Memory Clock 1,502MHz actual 1,502MHz actual 1,375MHz 854MHz

Frequency

L2 Cache Size 1,024KB (512KB per : 512KB 768KB 1,536KB (768KB per
GPU) GPU)

Frame Buffer Size 4,096MB (2,048MB 2,048MB 3,072MB 3,072MB (1,536MB
per GPU) per GPU)

Memory Interface 2x 256-bit 256-bit 384-bit 2x 384-bit

Memory Data Rate 6Gb/s 6Gb/s 5.5Gb/s 3.4Gb/s

Manufacturing Process 28nm 28nm 28nm 40nm

Transistor Count 7.08 billion 3.5 billion 4.3 billion 3 billion

Connectors 3x dual-link DVI, 1x 2x dual-link 2x Mini 3x dual-link DVI, 1x
Mini DisplayPort 1.2 DVI, 2x HDMI DisplayPort, 1x Mini DisplayPort 1.1a

1.4a (Fast), 2x dual-link DVI, 1x
DisplayPort 1.2 HDMI 1.4a (Fast)

Power Connectors 2x 8-pin 2x 6-pin 1x 6-pin, 1x 8-pin 2x 8-pin

Thermal Design 300W 195W 250W 365W

Power (TDP)

* Note: Nvida and AMD graphics compute cores are not directly comparable.

The GK110 will first appear in the
Tesla K20, an enterprise-level
card focused on GPU computing,
not graphics. It contains a whop-
ping 7.1 billion transistors—dou-
ble that of the GK104—and will
have up to 2,880 CUDA cores. The
GK104 has 1,536. The GK110 will
also support Dynamic Parallel-
ism and Hyper-Q, two technolo-
gies that make it very attractive
for GPU computing but won't be
relevantto gamers. The Tesla K20
is coming in Q4 2012, so we'd ex-
pect a consumer videocard based
on the GK110 sometime after that,
if atall. Don't hold your breath.

Nvidia released this GK110 die shot in May.
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high water mark established by the AMD Radeon HD 5970 a few
generations ago. It takes up the usual two PCI expansion slots.
It requires one x16 PCle slot, two 8-pin power connectors, and is
fully PCle 3.0 compliant. The rear of the card contains three dual-
link DVI ports and a DisplayPort 1.2 port, and the GTX 690 can
actually drive four monitors at once.

Rather than the usual black plastic, Nvidia has wrapped
the GTX 690 in chromium-plated cast aluminum, with an
injection-molded magnesium-alloy fan housing. Polycar-
bonate windows cover the vapor chambers over each GPU
while keeping the cooling channels visible. The “GeForce
GTX" logo on the side even lights up. Our one complaint
about the GTX 690's externals is the same one we had about
the GTX 590: The center-mounted fan blows hot air toward
both the front and the back of the videocard, working against
the normal front-to-back airflow of a typical cooling setup.

It's clear that Nvidia spent serious time working on this refer-
ence shroud, and it looks amazing. But looks aren’t the reason to
buy a graphics card: Nvidia says the precision-machined alumi-
num and metal cut down on vibration and fan noise. All that's very
cool, of course, but you can’t judge a videocard by its cover—or by
the nice things its manufacturer says about it.

The Inside Scoop

The GTX 690 contains two of Nvidia's premiere Kepler GK104
GPUs—the same GPU as in the top-tier GTX 680 single-GPU
card. We've discussed the Kepler architecture at length,
most prominently in our June 2012 feature article ("Nvidia's
Kepler: Overcoming the Sins of Fermi”], so we'll refrain from
discussing the basic architecture, but it's Nvidia's fastest,
coolest, most power-efficient top-end GPU to date.

The GTX 690's two GK104 GPUs sit on each side of the
center-mounted fan and are connected to each other and to
the motherboard via a 48-lane PLX bridge chip. Each chipisa
full GK104: 1,536 CUDA cores, 128 texture units, 64 ROPs, and
2GB of 256-bit GDDR5, for a total of 3,072 CUDA cores, 256
texture units, 128 ROPs, and 4GB 6,008MHz GDDR5 across
the card. The whole package has a TDP of 300W, compared to
195W for a single GTX 680.

Where previous dual-GPU cards, like the GTX 295 and 590,
had substantially underclocked GPUs to meet the board’s
thermal and power limitations, the GPUs on the GTX 690 are
only slightly underclocked: 915MHz with a 985MHz GPU boost
clock, compared to the 1,006MHz base and 1,058MHz boost
clock of a reference GTX 680. Nvidia has built in substantial

BENCHMARK

Nvidia GTX 680 SLI AMD Radeon HD 7970 Asus GTX 590

H : CrossFireX H
Price $1,000 $960 N/A
3DMark 11 Performance P15104 P15804 P13817 P9843
3DMark 11 Extreme X5800 X6072 X5352 X3300
3DMark Vantage Performance P44501 P45205 P44180 P36250
Unigine Heaven 2.5 (fps) E 59.8 60.8 57.6 35.9
Shogun 2 (fps) 37.9 38 75 31.6
Far Cry 2/ Long [fps) 184.7 187.9 186.3 129.3
Dirt 3 (fps) 122.9 124.5 114.5 73
HAWX 2 (fps) § 224 225 229 178
Metro 2033 (fps) 29.6 29.5 29 24
STALKER: CoP DX11(fps) 64.6 66.1 76.7 42.3
Just Cause 2 (fps) 79.31 81.03 91.85 54.91
Batman: Arkham City (fps) 102 104 86 68
Base Clock (Actual) § 915MHz 1,006MHz 1,000MHz 608MHz
Boost Clock 985MHz 1,056MHz N/A N/A
Memory Clock 1,502MHz 1,502MHz 1,425MHz 854MHz
System Power @ idle (W) 101 110 102 105
Max System Power M full throttle (W) 813 815 613

| 567

Best scores bolded. Our GPU test bed consists of a stock-clocked Intel Core i7-3960X on an Asus P9X79 Deluxe board with 16GB DDR3/1600, a 2566B Samsung 830 Series boot SSD, and a 1050W Thermaltake
Toughpower Grand PSU, in a Cosmos Il chassis. All tests performed at 2560x1600 with all settings maxed and 4x MSAA except where noted. Power use measured with a Watts Up Pro.
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room for overclocking, too, and proclaims 1,100MHz-plus
boost clocks from the stock configuration. Regardless,
Nvidia says a stock-clocked GTX 690 will perform to within a
few percentage points of SLI'd GTX 680s.

Performance Double

We tested the reference GTX 690 against two-card setups of
the fastest single-GPU reference cards on the market: two
GTX 680s in SLI, and two Radeon HD 7970s in CrossFireX. To
see how far we've come, we also tested an Asus GTX 590—
Nvidia's last-generation dual-Fermi card. We tested each
configuration on the same test bed: a stock-clocked Intel
Core i7-3960X on an Asus P9X79 Deluxe board with 16GB
DDR3/1600, a 256GB Samsung 830 Series boot SSD, and a
1050W Thermaltake Toughpower Grand PSU, in a Cosmos
Il chassis. We ran every test on 64-bit Windows 7 Profes-
sional SP1 using the latest drivers available for each card
at the time of testing. We ran all the gaming benchmarks at
2560x1600 resolution with all settings maxed and antialias-
ing set to 4x MSAA where available. PhysX was turned off in
games that used it.

If the GTX 690 is one thing, it's fast. If it's two things, it's
fast and consistent. In every benchmark, the GTX 690 is just
slightly slower than two stock-clocked GTX 680s in SLI—on
the order of one or two frames per second at 2560x1600.
The Kepler setups perform better, by a little, than the
CrossFireX'd Radeon HD 7970 reference cards in Unigine
Heaven 2.5, Far Cry 2, and Metro 2033, and by a wider margin
in Dirt 3and Batman: Arkham Asylum. The Radeons push out
decent wins in Just Cause 2 and Stalker, with a large advan-
tage in Total War: Shogun 2.

The GTX 690, SLI'd GTX 680s, and CrossFireX'd Radeon HD
7970s all kick the snot out of the dual-Fermi GTX 590 (origi-
nally reviewed June 2011). In boring lockstep with Nvidia's
promotional materials, the GTX 690 is between 20 percent
(in Shogun 2} and 66 percent (in Unigine Heaven] faster than

RADEON HD 7990: COMING SOON®

The Radeon HD 7990 is

working on the Trinity APU.

currently slated for a July
2012 launch, according to
a source familiar with the
project. Why not earlier?
First, our source claims
that AMD’s Radeon HD 7970

is handily outselling Nvid-
ia’s GTX 680, at least in part
because of Nvidia’'s scarce

supply of GK104 parts
(though Nvidia denies any
yield issues), so AMD’s in no
hurry to release a dual-GPU
card. Second, most of AMD’s
driver engineers have been

With Trinity’s launch, those
engineers are free to work
on Radeon drivers. This
leads us to the third thing
our source said: AMD won't
release the Radeon HD 7990
untilit can beat the GTX 690,
which the company thinks
it can do in time for a July
launch. Nvidia, by the way,
says it doesn’t anticipate a
serious GTX 690 competi-
tor for the next six to nine
months. Fightin” words!

the GTX 590. It also draws less power—we saw a peak total
system power of 567W for the GTX 690, compared to 613W
for the GTX 590 and over 810W for each of the two-card
setups. All four setups idled between 101W and 110W, though
the AMD has ZeroCore technology, which drops card power
consumption to just 3W when the attached monitor is off.
Nvidia's cards lack this feature.

The GTX 690 isn’'t necessarily quiet, but it's not loud. We'd
be happier if the airflow didn’t wreak havoc on conventional
cooling systems, but the central fan keeps both GPUs cool,
so we can’'t complain too much.

Overkill, Or the Right Amount of Kill?

The Nvidia GTX 690 is the fastest consumer graphics card
you can buy. It's roughly as fast as two GTX 680s and
beats dual Radeon 7970s in most benchmarks. That is to
say it's roughly twice as fast as the fastest single-GPU
cards on the market. That's a big deal. Expect third-party
vendors to ship factory-overclocked versions that'll be
even faster.

It's also $1,000 dollars, and it's complete overkill for
most gamers. Most people don’t even need one GTX 680,
much less two, unless you're gaming on multiple high-
res panels. In 3D. On the other hand, GPU compute users,
visual artists, and other people who need massive render-
ing power immediately but aren’t in Tesla or Quadro terri-
tory might find the GTX 690 a budget option.

If you really do need multiple top-end GPUs, the GTX 690
takes up less room and draws less power than two 680s,
but costs the same amount and makes less noise. It's the
obvious choice for an SLI setup. And if you're an AMD fan?
The Radeon HD 7970s still outperform a dual-Kepler setup
inafewbenchmarks, but AMD hasn’'t revealed its dual-GPU
Southern Islands card yet. The rumored 7990 is just that:
rumored. Given the performance of the GTX 690, though,
we hope AMD has something special up its sleeve. b

We hope the 7990 doesn’t look
as plain-Jane as AMD’s last
dual-GPU card, shown here.

AUG 2012 | s | 41



42 | wmonr | Aug 2012




By Gordon Mah Ung

BREAKING IN OUR NEW

BENCHMARKS

WE UNVEIL A GAUNTLET OF
NEW TESTS FOR PCs

that the only thing a performance

computer is good for is running
benchmarks. This dis at benchmarking
suggests that such performance measures are
pointless.

We disagree. We honestly think that
benchmarks keep the hardware world honest.
They give you a real metric with which to
measure one piece of hardware against
another, or one system against another. Yes,
there are times when politics get injected
into benchmarks and they can be misapplied,
cooked, or even cheated on. But think of what
the world would be like without benchmarks.
A vendor could make claims that his gadget
is faster than the competitor’'s. An Internet
declaration claiming a PowerPC Mac was 10
times faster than a Pentium Il would stand as
truth. Agood benchmark run well and analyzed
correctly can tell you more about a piece of
hardware than any marketing flyer.

Since Maximum PC’s system benchmarks
haven't been updated since the last decade,
we're rolling out newer, more punishing
tests that push today’s hardware. We're also
using real-world workloads such as gigapixel
imaging and multiple 1080p streams to closely
match what people are doing today.

With new benchmarks also comes a new
zero-point system to give you a reference point
for how today’s fastest PCs perform. And after
we’'ve given you a tour of our official system
tests, we’ll point you to some benchmarks you
can run at home on your own rig.

T here's a joke in the hardware community
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We didn't need benchmarks to tell us our
Nehalem-based test bed was dragging ass

If we tell you how fast some new $5,000
PC is, it doesn't mean much without a
reference point. That's why we build
standard zero-point PCs to compare
machines to. It's hard to believe, but
our previous zero-point is now several
generations old. It's still serviceable
for many folks, but when it's meant to
be our measuring stick for some of the
fastest production computers in the
world, it better have some chutzpah.

In choosing our parts, we spent
some time pondering whether to go
LGA1155 or LGA2011. Quad-core or
hexa-core? Single GPU or dual? In the
end, we decided that more cores still
matter, so Intel’'s Core i7-3930K would
be the basis of our new ZP. Yes, it's
based on the older Sandy Bridge mi-
croarchitecture, but it still has plenty
of speed, and LGA2011 gives us an
upgrade path to lvy Bridge-E and per-
haps an eight-core chip in the future.
The 3930K is stock-clocked at 3.2GHz
with Turbo Boost to 3.8GHz. We decid-
ed to override the stock clock and run
itat 3.8GHz full time, with Turbo taking
itto 3.9GHz.

For storage, we are finally unshack-
led from SATA 3Gb/s speeds with the
X79 chipset, via an Asus Sabertooth
X79 board. A 120GB OCZ Agility 3 gives
us zesty SATA 6Gb/s reads and writes
and has enough capacity to handle
our benchmarks. For graphics, we've
long used a single-card dual-GPU and
we continue that trend with Nvidia's
benchmark- and wallet-busting Ge-

A hexa-core CPU and top-of-the-line
GPU give us a good baseline against

which to judge new systems.

=
=]
=
o
-
b

Force GTX 690. It's basically the equiv-
alent of two GTX 680 cards—in perfor-
mance and cost. The rest of the build is
essentially borrowed from the $2,100
Tax Refund PC in our May 2012 issue

SPECIFICATIONS

oLD NEW
CPU 2.66GHz Core i7-920 (at 3.5GHz) 3.2GHz Core i7-3930K (at 3.8GHz)
Cooler Thermalright Ultra-120 NZXT Havik 120
Motherboard Gigabyte X58 Asus X79 Sabertooth
RAM 6GB DDR3/1750 in tri-channel mode 8GB DDR3/1600 in quad-channel mode
GPU AMD Radeon HD 5970 Nvidia GeForce GTX 690
SSD 160GB Intel X25-M 120GB OCZ Agility 3
HDD 1TB WD Caviar Black 2TB WD Caviar Green

PSU Corsair TX850

Corsair HX850

and includes 8GB of 2GB DDR3/1600 in
quad-channel mode, a 2TB WD Caviar
Green drive, an 850W Corsair HX850
PSU, and an NZXT Phantom 410 case
and Havik heatsink.

To create our benchmarks, this
wasn’t the only hardware we used. Ad-
ditional testing was also done using a
stock Core i7-3770K and GeForce GTX
580 card. We also tested our bench-
marks using an O0CZ Revo 3 X2 card to
see how much of an impact 1/0 would
have on the individual tests. It was
negligible.

The total cost of our new zero-
point? Roughly $2,500. That puts it in
the upper echelon of what most people
spend on a new machine, but certainly
nowhere near the high-end rigs we've
tested already.
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toward real-world workloads

We've been envious of the Mercury
Playback engine since Adobe intro-
duced it in Premiere Pro CS5. In Pre-
miere Pro CSé6, Adobe has tucked in
even more enhancements to make it
probably one of the fastest, if not the
fastest, nonlinear editor on the planet.
That presented a few problems for us,
though: Do we render using the wick-
edly fast GPU or the CPU? Using the
GPU could cut our times by several fac-
tors, but not all machines support the
GPU encoding. In the end, our problem
was solved for us, as the GTX 690 is not
currently supported by the Mercury
Playback engine, so it's CPU all the
way. That doesn’t mean the benchmark
is a wimp. We find the multithreading
in CSé to be impressive. All 12 threads
on our Core i7-3930K are hammered
during the export. For the workload,
we take 1080p video previously shot
on a Canon EOS 5D Mark Il, add tran-
sitions and moving picture-in-picture
frames with additional 1080p footage,
and export it to H.264 formatted for
Blu-ray. The six cores in our 3930K pay
dividends, as our render took about 33
minutes. A stock lvy Bridge setup took
about 53 minutes.

We chose our tests with an eye

Sehect andt smange Images

The GigaPan
Epic Pro uses
a motor to pan
your DSLR

to create
gigapixel
images.

o

£ GigaPa"

New to our stable is Stitch.Efx 2.0.
Let's face it, applying a sepia filter

and scratch effects can be done on a
$50 smartphone. Since PCs are about
going big, we went as big as we could
get. We used a motorized GigaPan
Epic Pro head, a Canon EOS 7D, and a
300mm lens with 1.4x teleconverter to

) L [ T P
= -Hﬁﬁwﬁﬁﬁﬁﬁﬁ

e e
o
=
ey
=

46 | wmome | Aug 2012

Stitch.Efx is one-third single-threaded and two-thirds multithreaded. We use it to
stitch together 1.6GB of JPEGs into one single 1.1-billion-pixel image.

shoot a panorama of 287 images total-
ing 1.63GB. Using Stitch.Efx we stitch
the shots into a single continuous 1.1
gigapixel panorama. Yes, that's 1.1 bil-
lion pixels, or 1,100 megapixels. (That
might sound like a lot, but it's nowhere
near the current record of 272 gigapix-
els—also shot with an Epic Pro head
and 7D.)

About the first third of the process,
where the app aligns the images, is
single-threaded and sensitive to clock
and microarchitecture. Ivy Bridge
cores give the Sandy Bridge cores a
good run for the money in this section,
but in the blend section it's all about
the cores and this is where we see SB’s
greater number of cores pull ahead
of the Ivy Bridge chip. As we stitched
“only” 287 images together, it's mostly
a CPU test, but we can say the process
created no fewer than 24,339 files dur-
ing the stitch, so small-file read and
write performance should matter. With
its mix of single- and multithreaded
performance, Stitch.Efx2.0 is a good
representation of today's software.
Look for a review of the Epic Pro head
on MaximumPC.com—perhaps we'll be
going for that record ourselves.
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Since our Premiere Pro CSé test actu-
ally features MainConcept's popular
encoding engine, we cast about for an-
other publicly available encoding test
and found one in the newly released
x264 HD 5.0. Created by tech website
TechARP.com, the test uses the x264
library to encode a 1080p video stream
multiple times. The benchmark is mul-
tithreaded and loves cores. It performs
two passes, with the second pass com-
pressing the compressed material
even further to save space. We run in
64-bit mode and report the average
frame rate for the second pass. In our
testing, the hexa-core Core i7 smash-
es the newer Core i7 lvy Bridge in the
nose by a significant margin. We've
found that encoders can be sensitive
to memory bandwidth, so we reconfig-
ured our machine from quad-channel
to dual-channel mode (using larger
DIMMs so the total amount of RAM
would remain the same) and found a
negligible difference.

Favored by professional photogra-
phers, ProShow Producer 5.0 is a pop-
ular slideshow creator that we've long
used as a benchmark. For our new
benchmarks, we update to the latest
version of the app, which adds GPU ac-
celeration, but only for video playback.
When we started using ProShow Pro-
ducer five years ago, it was one of the
few apps that could push quad-core
chips to their limit. Unfortunately, the
app seems to top out with four cores,
but that's fine. We intentionally picked

ProShow Producer 5 gets GPU support, but for playback only. It's currently
optimized for “only” quad-core support.

ProShow Producer 5.0 knowing full
well that it doesn’t scale with cores.
Like Stitch.Efx 2.0, we wanted some-
thing that's closer to most apps in per-
formance instead of simply scaling as
you add more cores. Why pick some-
thing that won’'t push an eight-core
chip to its limits? The sad truth is that
the vast majority of apps can’t exploit
the threads.

Arkham City is based on a heavily mod-
ified version of the Unreal Engine 3 and

BENCHMARKS

POINT
Premiere Pro CSé (sec) 2,000 3,067 (-35%)
Stitch.Efx 2.0 (sec) 831 893 (-7%)
ProShow Producer 5.0 (sec) | 1,446 1,522 (-5%)
X264 HD 5.0 (fps) 211 14.3 (-32%)
Batman: Arkham City (fps) | 74 21 (-72%)
3DMark 11 X5,847.0 X2,115 (-64%)

0% 10% 20%

30% 40% 50% 60% 70% 80% 90% 100%

For comparison, we ran our benchmarks on a stock quad-core 3.5GHz Core i7-3770K on an MSI Z77A-GDé5, with 8GB of RAM, a GeForce

GTX 580, a WD Raptor 150 drive, and 64-bit Windows 7.

adds the latest DX11 bells and whis-
tles. We run the test at 2560x1600 with
8x AA, tessellation on High, and detail
on Extreme. Why not use some of the
more advanced AA settings available
from Nvidia or AMD? Since this test
will be used on systems, it can be dif-
ficult to compare a proprietary anti-
aliasing technique from one vendor
against another vendor that doesn’t
support it. Even at 8x AA and every-
thing cranked up, the GeForce GTX 690
makes mincemeat of the benchmark.

Our last benchmark is Futuremark’'s
3DMark 11. We normally eschew syn-
thetic benchmarks in favor of real-
world benchmarks, but we have relied
on the various iterations of 3DMark
over the years. We're choosing it here
because it scales well with multiple
GPUs, and this version doesn’t seem to
represent the typical game of political
football between rival graphics com-
panies that previous versions have.
For our test, we run the default bench-
mark for the Extreme preset.
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HOW TO BENCHMARK
LIKE AN EXPERT

Lessons from the Lab that you can apply

to your own testing methods

As any veteran nerd will tell you, running
a benchmark is just half the equation.
The other half is actually being able to
understand the limits of the benchmark
and how to analyze the results. You can't,
for example, use 3DMark to evaluate your
hard drive performance. Most people
know this, but do they know the limits of
other benchmarks?

THE FUNDAMENTALS

Before you begin your benchmarking, there
are a few basic rules that every techie has
learned through blood, sweat, and tears.
First, record all your settings. From bclock,
to RAM timing, to GPU clocks, drivers, and
BIOS settings, you should keep a written
record that you can refer back to. Second,
you're human and make mistakes. If the
result from B outrageously exceeds A, as-
sume you made a mistake and retest. Third,
double-check your system. Are you in the
correct SATA port? Is the RAM fully inserted
and in the correct memory mode? Is the CPU
overheating and throttling? Fourth, triple-
check your settings. Yeah, this is the second
tip again, but more often than not, user error
isthe cause of errors in tests. Finally, bench-
marking doesn’t have to cost money. Here
are a few free and reliable benchmarks and
how to interpret their results.

MAXON CINEBENCH 11.5
Cinebench 11.5 is a great test of pure
CPU performance. The benchmark is
based on Maxon’s Cinema 4D rendering
engine and is heavily multithreaded. The
test also features an OpenGL rating. So
what's the catch? Cinebench’s render-
ing test is best used to test CPU per-
formance only. As a system level test,
any variances you see between system
A and system B will be due to the CPU
and not the hard drive, SSD, or memory
bandwidth. It's virtually worthless to
try to use it as, say, a motherboard test
using the same chip, because any vari-
ances will be due to how much the ven-
dor tweaks the board’s bclock settings.
OpenGL also has little value for main-
stream users, as very few games even
use OpenGL anymore. www.maxon.net

TECHARP X264 HD 5.0

We've just started using TechARP’s x264
HD 5.0 benchmark, but we like it already.
It gives you an easy, repeatable way to
test the encoding prowess of a ma-
chine. Be advised that, like Cinebench,
it seems to be almost completely com-
pute-bound. We tested it in dual-chan-
nel mode and quad-channel mode on a
hexa-core chip and found a very minor
difference resulting from memory band-
width. Testing from a single SSD to a
RAIDed PCle SSD also yielded very little
difference. www.techarp.com

UNIGINE HEAVEN 3.0

For graphics, Unigine’s Heaven 3.0 is a
great way to measure tessellation per-
formance and will push even the fastest
cards. It even has a Mac version, but with-
out tessellation. Multiple GPUs help this
benchmark, which is purely focused on
the GPU. Quad-core, hexa-core, low clock,
or high clock hardly make a difference in
this test. The free version of Futuremark’s
3DMark11 will also work—but only for the
Performance preset. www.unigine.com

CRYSTALDISKMARK 3
We've also been happy with CrystalDisk-
Mark, which is easy to run and gives you a

File Edit Iheme Help Language
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CrystalDiskMark 3.0 is a reliable way
to measure disk performance but not
across an entire disk or SSD.

good feel for your disk subsystem’s per-
formance. Keep in mind, one limit with
the test is that the workload is limited
to 4GB, so even a hybrid drive could per-
form like an SSD. www.crystalmark.info

Folks interested in measuring their
memory bandwidth should check out
SiSoft Sandra 2012 (bit.ly/LaYsdy). The
free version offers a host of bench-
marks, including a synthetic memory
benchmark. Keep in mind, though, with
the large-cache CPUs today, it's very
difficult to see an impact from memory
bandwidth unless you are running inte-
grated graphics. b
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Cinebench 11.5 is best used as a pure CPU-performance benchmark and
applications outside of that should be carefully weighed.

AUG 2012

momne | &9



RG_D ‘ [} examining technology and putting it to use

IREIESV

THIS MONTH WE DISSECT...

Barnes & Noble Simple
Touch with GlowLight

7Fixit
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MAJOR TECH SPECS:

In an attempt to solve the centuries-old problem of how
to read in the dark, Barnes & Noble brings us a revamped
version of last year's Nook Simple Touch. The specs are
identical to that model, with one main addition:

¢ Adjustable GlowLight technology

e 2GB internal storage, supports up to 32GB of additional
storage via microSD card

e 16-level grayscale 6-inch E-Ink touchscreen with a max
resolution of 600x800 pixels

¢ 802.11b/g/n wireless connectivity

KEY FINDINGS:

e [t appears that only a single T5 Torx screw, which is easily
removed with our 54 Bit Driver Kit, stands between us and
the glowing innards of the newest Nook.

e Although the concept behind Barnes & Noble’s GlowLight
technology seemed super-simple at first—just some in-
expensive LEDs on top of the screen—we knew there had
to be more tech packed inside in order to evenly light the
screen.

e The glass in the display assembly includes a diffraction
grating that disperses the light from the Nook's eight LEDs
to achieve even distribution. Barnes & Noble must have
spent a good amount of time optimizing this diffraction
surface for the uniform lighting, which is why it has kept
the technology in-house and is filing for a patent.

e Besides uncovering the magic of GlowLight, we found
this device to be quite similar to the older Simple Touch.
The board looks almost identical, save a connector for the
GlowLight LEDs. The other noticeable differenceis a frame
made out of magnesium, as opposed to the aluminum plate
found in the non-Lit Simple Touch. (We verified this magne-
sium claim the hard way, as our burnt fingers will attest).

e Barnes & Noble claims that the battery provides, at an
average of one hour of reading per night, one month of us-
age per charge with the GlowLight on or two with it off.
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STEP-BY-STEP GUIDES TO IMPROVING YOUR PC

Window ) 5 -
Assign commands to different mouse actions.
Tabs
Twes To add a mouse binding, perform a mouse action on the plus icon to the left of the appropriate target
wesks type. To remove a binding, select it in the list and press the Delete key.
Tooltips
Mouse Chord Action
General R Uhck Lo torward
Appearance Ctrl = X1 Click Go back to start
Ctrl + X2 Click Go forward to end
Mouse
[+] Tab
Keys Middle Click Close tab
Groups Ctrl + Left Click Lock
P Double Click Up one level
Applications
[+] Tab Bar Background
Button Bar Double Click Cpen new tab
Plugins Middle Click Undo close = B
Language [+] Folder Link Nothing
) Middle Click
About Ctrl + Middle Click
[*] File or Falder Close all but current
Middle Click Close windaw
: - Undo close
Ctrl + Middle Click Clone current tab
[+] Explorer Background Cpen current folder in new window
Double Click Lack / unlock all -
Erouss fal

UPGRADE WINDOWS EXPLORER WITH QTTABBAR

Why is it that Windows Explorer—one of the most fundamental aspects of the
Windows experience—has evolved more slowly than any other part of the 0S?
Force Explorer into the new millennium with QT TabBar, a mod package that
adds tabbed browsing and tons of customization to good ol" Explorer.exe. It's in
active development at http://qttabbar.sourceforge.net.

56
Speed Up Boot Install Android on
Times with Your PC

Startup Delayer

ALEX CASTLE
ONLINE MANAGING EDITOR

THREE TYPES
OF SLOW PC

trying to figure out
why a PC’s running slowly, |
start by grouping it into one of
three broad categories:

Puny hardware: This is
what us computer nerds al-
ways wish the problem was.
Who doesn’t love an excuse to
buy some more RAM, after all?
Easily diagnosed with dxdiag or
the Windows Experience Index,
it's the least common culprit.

Badware: Viruses and mal-
ware can cause the worst
slowdowns, and are usually
fairly easy to notice. Diagnose
and remove with antimalware
programs like Spybot Search
& Destroy and Malwarebytes’
Antimalware.

Just plain too much stuff:
The most common and most
frustrating cause, too many
installed programs will slow
your computer down even if
they're not malware. Diagnose
with hard disk visualizers (see
last month’s column] and the
System Resource Monitor, and
treat with CCleaner and Start-
up Delayer.

N comments@maximumpc.com
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Spee
with Startup L

YOU'LL NEED THIS
STARTUP DELAYER

This free tool lets you define

a priority list of the order in
which booting tools should be
loaded into memory. It can load
these utilities over a set amount
of time or when it sees your
machine isn’t busy.

d Up Boot Times

PROGRAMS SHOULD know their place, sit-
ting on your desktop silently and unob-
trusively until called for. Instead, more
and more of them try to run every time
you load Windows, slowing your PC to
a halt regardless of whether or not you
want to check for updates, log into your
games service, or whatever else they do.

The more software you have installed
on your machine, the more you'll notice

elayer

be whole minutes between your desktop
appearing and you being able to do any-
thing with it. Luckily, there are ways to
cut through all this. First we'll do a little
spring cleaning. Then you'll find out how
a tool called Startup Delayer can space
out the applications you do want to load
automatically, letting Windows handle
them quickly, efficiently, and discretely
behind the scenes.

www.r2.com.au

thing, click the arrow icon in the system tray to see which programs

load automatically. Right-click each one to bring up a menu that
should explain what they are. Common apps include your graphics card
Control Panel, software update checkers, and antivirus, but every PC
will be different.

» Some programs, like antivirus software and Dropbox, need to be
loaded and running, and can be left as they are. Other apps, like Steam,
can be loaded when you need them. Right-click each of these and look
for an option along the lines of “Run when Windows starts.” If you don't
see one, open it, and look in its Preferences/Options menu instead.

I MAKE MANUAL TWEAKS Boot your PC and, without loading any-

www.r2.com.au to download Startup Delayer. Launch the set-

up file, letting it make a System Restore Point just to be on the
safe side, and allow it to run. It will take a few seconds to scan your PC
for applications and give you the option to load the help file. You can
safely skip this part, at least for now.

» First, you need to tell Startup Delayer your priorities. These are
based on asliding scale that goes from loading your applications as fast
as possible (all the way to the left) to only loading the next one when your
PC is effectively sitting idle. As a starting point, we recommend going
with the third or fourth notch from the left (image AJ.

2 GET STARTUP DELAYER Open your web browser and visit

Homal Startug:

L= »
e:ﬁmﬂ How would you like Startup Delayer to Behave?
() DAFMON Took Live
37 Drepbun
Brop:
hGooghe Updute

A Livedsive My CPU 1'd iee my
awallabibe in a timely manmer and don't mind a few hicoups and stalls as they start. | don't mind that

Start Fast

The Default CPU and Disk idle vaiue will be set fo J0% in order to accomplish the above nelection. These
ket car be madified kiter in the Optiont window

T U

the problem—to the point that there can

grams are classed as Normal Startup, which means

Delayer loads them as soon as possible limage B). Es-
sential software like antivirus should remain here, but the rest
can be setas Delayed, meaning they wait untilyour PC is sitting
idle. You can also drag apps into Disabled if you can't prevent
them from loading automatically.

» Once theyre in the Delayed list, you'll see that each ap-
plication is numbered (image C). This is the order in which
Startup Delayer will load them when it finds a quiet moment.
To reorder them, simply select one you wish to move, click on
it,and drag itinto its new position. Applicationsin the “Normal”
list don't have a number, all being loaded at once.

» If necessary, you can take charge of individual applica-
tions by selecting them, then assigning either an automatic
[based on how hard your processor/hard drive is working) or
timed delay. Both of these options are listed at the bottom of
the screen. You can also hold Shift or Ctrl to select and delay
multiple applications at once.

» Restart your PC and see the difference. The more appli-
cations you had running the greater improvement you'll see,
but any machine should feel noticeably faster.

3 CONFIGURE YOUR LAUNCH ORDER By default, all pro-

EE [} Startup Applications

8| Running Tasks H £ System Services ‘
& |+ Richard | | Add New | Tod
Startup ltem Order/... Name Status
Delayed

(Drop Applications here to Delay)

Mormal Startup

CB AdobeAAMUpdater-1.0 Standard Adobe Updater Startup Utility

Tamd_dc_opt Standard  AMD Dual-Core Optimizer Stopped

o5 AVG_TRAY Standard  AVG Intemet Security Running|

@ DAEMON Tools Lite Standard  DAEMON Tools Lite Running|

Startup em Orderf... | Name Ste ™
Delayed

[ih1st - Google Update il Google Update Stoppe

[F2nd - AdobeAAMUpdater-1.0 2 Adobe Updater Startup Utility Stoppe

®3rd - DAEMON Tools Lite 3 DAEMON Tools Lite Runni

lth - SunJavalpdateSched 4 Java(TM) Platferm SE Auto Updater 20 Runnil

M 5th - AVG_TRAY 5 AVG Internet Security Runni
Normal Startup

Temd _de_opt Standard  AMD Dual-Core Optimizer Stoppe

Standard Dropbox
B Fraps Standard  FRAPS Stoppe

£ NUSBIMON Standard  USB 3.0 Monitor Runni

AU DALIN L Shamalnsd o Daabale LD, Aussdin A1 B,
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Install Android on Your PC

YOU'LL NEED THIS

ASUITABLE PC

You can use any PC for pre-ICS Android, but
you'll need a netbook or Intel-based machine if
you want to try experimenting with Android 4.0
Ice Cream Sandwich.

USB STICK/VIRTUALBOX
You'll need the stick for some installations and
VirtualBox 4.18 for others (www.virtualbox.org).

ANDROID

We're using the Nightly build of Android 2.2
from http://android-x86.moonman.dk, and the
ISO image of 4.0.3 built for the generic platform

THE GREAT THING about Android is
that it's open source, which means
any developer can grab the code to
Android and do what they want with
it—and now you can, too. With a lit-
tle work, you can get Android run-
ning on your PC right now, for free.

The main challenge is that most
Android devices run on ARM pro-
cessors, and porting it to run on
anything else is a big challenge.
Google does provide tentative sup-
port for the x86 architecture within
the codebase, but it wouldn't be
possible at all without the exis-
tence of a project called Android-

—Graham Morrison

x86 that pulls all this together with
a considerable library of patches
to create a build of Android that
mostly works on Intel or AMD pro-
cessors.

The project has been able to
make earlier releases of Android
run fairly stably on the x86 plat-
form, including networking and
mouse support. But the Ice Cream
Sandwich version of Android still
has some bugs running on x86,
so we'll start by showing you how
to install an earlier, more stable
build on your PC.

from www.bit.ly/xwBkmY.

by running an older version in a virtual machine environment.

This is safe, maximizes functionality, and walks a well-trodden
path. If you like it, you can move onto a newer version later. We used
VirtualBox, though other virtualization programs should work, as
well. Android works better on Intel hardware due to modifications
in the source code, but we saw no difference on our AMD machine
aside from a couple of warnings.

» We've had the best experience with the Nightly build of Android
2.2, which you can grab from http://android-x86.moonman.dk. With
the ISO downloaded, launch VirtualBox and click the New button. In
the wizard that appears, set the operating system to Linux, and set
Other Linux as the version. We gave our machine 512MB of memory,
and a 2GB hard drive as a VDI disk image.

» After the new machine has been created, select it in the ma-
chine list and open the Settings window. On the System page, switch
to the Processor tab and make sure Enable PAE/NX is active for your
CPU. Now click the Storage page. VirtualBox defaults to IDE emula-
tion rather than SATA, and we need to add a second device to attach
to our ISO image. If the device doesn’t exist, click the controller fol-
lowed by the “Add a new attachment” icon (which looks like an optical
disc). A small window should appear asking you to choose a disc im-
age, and you should point the resulting requester at the Android 2.2
image. If an optical drive already exists, select it in the storage tree.
Use the disc icon on the far right to display a drop-down menu, then
select “Choose virtual CD/DVD disk file” [image D).

I SET UP A VIRTUAL PC We'll take our first foray into Android

Agrouies
o (MeCOTYD | (3 Chooum s sl COND) di
{

Indormaion Host Drive HL-DT-ST DVD-AAM GEAHSSN (w0

Type image | feneric_sbe-201 201 tRiss

Bze TII0MS

Lokt e adecichaBE-4 DHegand- 2012001 Ino

TG ARG 4 (-ama_laplop 20120101 e
AT BG4 0 ama_brated 20120101 rs0
(G Meenove dis rom vrtual drive

configured [image EJ, click OK in the Settings

window, and then click the green Start button
in the main interface. Android 2.2 will boot within the
virtual machine. You'll see the boot menu (image F],
from which you should choose the first option. HDPI
and MDPI refer to the screen resolution of the output
device, which you can ignore when running on any-
thing other than a tablet. If you decide to try this boot
onreal hardware, then the third option avoids graph-
ics drivers by using the VESA mode. This is useful if
you run into compatibility problems. If you like what
you see with Android, the final option will create a
permanent installation on a spare drive partition. A
few moments after making your choice, you'll see
Android’s unlock screen. The final hurdle is over-
come by pressing the right Ctrl key and selecting
“Disable mouse integration” from the Machine menu.
Now when you click the virtual machine, you should
see the mouse and be able to slide the padlock icon
up to enter the 0S.

2 INSTALLANDROID 2.2.1 Now that everything is

Hard Digk
Acosiemton: VT-wAMDY, Nested Faging, PAENX

e Diapimy.

3 Storage

08 Cortrier

1DE Primary Master

1DE Sacandary Mister (CDOVD)
¥ audio

Host e PulpsAucsa
Comtrober  1CH ACST

Androic vos iNormal, 3 00 GEy
Qehens_sB6-201 2010866 (11 J0ME}

& Natwork

Adapier 1. PCnel FAST M (AT}
& use
Devce Fibers: 00 actve)

& Sharea Foiders

None

@ Dessaipuon
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findroid-x86 Live & Installation CD 2011-02-20

PEREDT = Run Andro id=x86 without installation (HDEL)
Live CD - Run Android-x86 without installation (MDPI)
WICETCD = VESA mode
IRoet G = Debug, mode
Installation - Install Android—x86 to harddisk

Press [Tabl to edit options

id-x86.0rg

played with Android 2.2 and want to upgrade to the

latest version. We'll show you how to install the Ice
Cream Sandwich Android build on your PC, without virtual-
ization. But before you can begin, you'll need to go to the
Android-x86 Project’'s homepage and download the most re-
cent Ice Cream Sandwich build (also known as Android 4.0.3)
compiled for generic x86 hardware.

» You can either burn the Android ISO file you download-
ed toa CD or onto a USB stick, which can then be booted on
the machine. If you want to create a bootable disc, you'll
need to download UNetbootin, which you can download at
http://unetbootin.sourceforge.net.

» First, insert your USB stick—1GB will do. All the data
will be lost, so make sure there's nothing on there you want
to keep, then launch UNetbootin. The top half of the win-
dow is used for selecting a Linux distribution, which can be
downloaded and installed automatically. We want to use the
bottom half to locate the ISO and ensure the correct USB
device has been selected [image G). If everything is correct,
click OK. This will start the conversion and begin to write the
bootable data to your USB stick. It should complete in a few
minutes.

» Like a live Linux distribution, Android can now be booted by
turning on your machine with the CD or USB device inserted. As
long as the BIOS or boot menu is configured to probe the right
device first, you should see the Android boot menu. This has
three options, with Default being added by UNetbootin. Choose
the first, “Run Android x86 without installation,” to test the 0S.
If everything works, you can choose to install at a later time.
Android takes a few minutes to boot. After the Android logo,
you’'ll see the starter wizard. This is where, on a real device,
you sync the hardware with your Google account, but without
network connectivity it makes no sense. Just click through the
options to get to the OS quickly.

» You'll now see the start page of Android. This adds a few
prompts to help you get started, but Android is easy enough to
use without any prior experience, especially if you tried ver-
sion 2.2.3 earlier. The main differences are in the transitions
and how the display looks, but all that can be changed, too.

3 UPGRADE TO THE REAL DEAL Hopefully you've now

Applications are launched from the small matrix icon
on the top right, and you can use the arrows in the
bottom left to move between what Android calls “ac-
tivities.” In normal terms, these are virtual desktops.
» Playing with the settings is the first thing you
should do. You can get to the Settings panel [image
H) by clicking the clock in the bottom right of the
display, then on the text that says "No Internet con-
nection.” Clicking the Wi-Fi icon will turn it on, and
hopefully you'll be able to scan for networks with
the Scan button at the top of the screen. Again, An-
droid on x86 is still a work in progress, so features
like networking may not work with your hardware.
If you encounter problems, remember to check back
soon—the project is updated frequently. 0

Distribution == Select Distribution == v ==Select Version == v

Welcome to UNetboetin, the Universal Netboot Installer. Usage:

1. Select a distribution and version to download from the list above, or manually specify files
toload below.
2. Select an installation type, and press OK to begin installing

|+, Diskimage /150 ~ | ownloads/android-xB6-4.C-asus_laptop-20120101.is0 |
Space used to preserve files across reboots (Ubuntu only): 0 o ME
Type | USBDrive v | Drive: | v || ok || cancel
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Reliving the Commodore
64 Glory Days

How to build a modern-day PC into a
replica of the world’s bestselling computer

THE MISSION Many people wax poetic about the polite '50s, the
radical '60s, or the wild "70s, but for nerds, the 1980s was the best
decade. A full-on war raged in the new category of “personal com-
puter,” no one operating system ruled the world, and, man, you
could walk into a Toys “"R” Us and buy the world’s all-time bestsell-
ing PC: the Commodore 64.

Whether you want to relive the golden age of PCs or you weren't
alive for it, Commodore USA [no relation to Jack Tramiel's original

Original C64

LENGTH OF TIME: 2 HOURS J LEVEL OF DIFFICULTY: INTERMEDIATE

Commodore International) offers its Commodore 64x to recreate
that 1980s experience.

The main difference between the original Cé4 and this replica
is the latter’s ability to take standard PC industry components.
Is the Commodore 64x case/keyboard a perfect recreation of the
original? No, but it's damn close. I'm not judging this by my faded
memories of the Cé4 | owned in 1982, either. See how closely the
inset shot of the original resembles the new C64x?
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WHAT’S INSIDE THE NEW Cé4?

1 HAD ENVISIONED using a Core i7-2600K with a notebook GeForce
graphics card in the Cé4x, but | quickly realized that heat would be a
serious issue in this thermally constrained PC, which has one puny
4cm fan handling all its airflow. | also considered a mobile Core i7,
but the cost and scarcity of parts made me ditch that approach. In
the end, | decided that an AMD E-350 Fusion APU would be the most
cost-effective and reliable route.

The best candidate for the job? Zotac’s Fusion ION-ITX T Se-
ries. The board features AMD’s E-350 Fusion chip, built-in Wi-Fi,
and, best of all, a 90-watt external power brick. Because the Cé4x
doesn’t have much room, running an internal power supply is out
of the question. Pico-ITX PSUs are an option for standard boards,
but that would require cutting a hole into the chassis to route
the wiring. The Fusion ION-ITX T Series takes care of that in one
swoop. Thermals also shouldn’t be an issue with its integrated
heat pipe and heatsink. My previous experience has taught me
that the E-350 runs super cool for an 18-watt part.

For storage, | opted for Seagate’'s Momentus XT hybrid drive. It
gives the Cé4x some SSD-like performance but is cheap enough
that | can afford to give the machine 750GB of storage space. A
Silverstone slot-fed DVD burner rounds out the package, but we
did have to add an NZXT internal USB expansion module and an
old-style Molex Y power splitter.

Fortools, a standard Philips-head screwdriver and a small jew-
elers Philips-head screwdriver are required for the build. | also
had to round up a set of system screws, as well as a set of screws
that are typically used to mount an internal 5.25-inch optical drive.

OPEN THE CASE

YOU'LLNEED TO unscrewsixscrewsalongthe perimeter of
the Cé4xfirst(image Al. Then carefully remove the keyboard
and place it aside. Now, find a cassette tape player and put
in your favorite mix tape of Olivia Newton-John, Survivor,
Joan Jett, the J. Geils Band, and the Human League. Yes, all
the top artists of 1982.

INGREDIENTS
PART URL PRICE
Case Cé4x www.commodoreusa.net : $345
PSU/Mobo/ Zotac Fusion
CPU/Cooler/ ION-ITX T
GPU Series www.zotac.com $199
Corsair 8GB
DDR3/1333
RAM SODIMMs www.corsair.com $44
Silverstone
oDD SST-S0-D02 www.silverstonetek.com $69
Seagate
Momentus XT
HDD 750GB www.seagate.com $155
NZXT 1UO1
USB Expansion
Miscellaneous module www.nzxt.com $20
One Molex
Y-power
splitters www.newegg.com $1
Zalman Fan
Mate 2 www.zalman.com $7
Total Cost $840

4

UNSCREW the four screws under the Cé4x. Note: You will
probably have to loosely hold the four nuts inside the case to
getthem loose. Oncethe screwsare out, removethetrayand
mount the 2.5-inch drive [image B]. The drive tray is coun-
tersunk to fit countersunk screws. Since Commodore USA
doesn’tinclude these parts (when they say bare-bones, they
meanit), we used four fine screws of the type that comes with
a 5.25-inch optical drive to hold the drive in place. This will
cause the tray to ride a little higher than it should, but don’t
worry: The loosey-goosey build quality of the drive opening
means the tray should still fit it. Mount the drive tray back in
placeandscrewitintothe caseusingthefourscrewsandnuts.
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INSTALL THE OPTICAL DRIVE

WE COULDN'T FIND a 170KB 5.25-inch floppy drive, so we
settled for this Silverstone slot-fed DVD burner. It comes with
fourtinyscrews. Placethedriveinthe cageandscrewitinplace
with the jeweler’s screwdriver [image C). Now plug in the HDD
powerand SATAcableaswellasthe ODD powerand datacable.

INSTALLTHE 1/0 shield by sliding it into the slots at the rear of
the Cé4x. Now gently slide the Zotac motherboard into place,
making sure the two Wi-Fi antennas feed out the holes in the
1/0 shield [image D). Take four screws from your spare parts
box (because why would Commodore USA bother to include
them in the box?) and gently screw the board in place [image
E]. The board doesn’t have metal standoffs, soyou'll be boring
the screws into plastic. Do not over-torque the screws or you
will strip out the mounts.

INSTALL THE RAM

INSTALL THE PAIR of SODIMMs by placing them into the slots
while carefully making sure the notches in the DIMMs line up
with the notches in the slots. Apply pressure with your thumbs
on the corners until the arms snap into place [image F).
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EXPANSION NEEDED

SINCE THE KEYBOARD is internal, it hooks directly into a USB 2.0
header.Unfortunately, the system’sinternalmediacardreaderalso
requiresaUSB2.0header, butthe Zotacboardwe selected hasonly
one internal USB 2.0 header and a USB 3.0 header. To get around
this,weusedanNZXT 1U01 USBexpansion module. The 1U01 needs
power, so take the Molex Y-cable splitter and plug it into the Molex
outputonthemotherboard (image G). Nowtake the Molex-to-SATA
power connectorthatcamewiththe motherboardandplugitintoone
end of the Y-cable splitter. Plug the other end into the 1U01's power
pass-through and then plug into the optical drive’s Molex cable.

Windows 7’sinstallerworks fine withthe NZXT 1U01 expansion
module, but if the OS you're installing doesn't like it, you'll need to
use a USB keyboard during the OS installin order for the installer
torecognizeyourkeyboard. Note thatthe expansion module shown
inthe photois slightly older thanthe current 1U01, but the installis
the same, and we tested with both units just fine.

HOOK UP THE KEYBOARD

THEUSBCABLEIisn'tlabeled, butthe wiresindicate what func-
tionstheydo. Theredwireis powerandtheblackisground. Look
at the USB pin-out chart we've provided [image H) and match
the keyboard connector that has the red wire with one of the
+5V pins and then plugitin [image ). If you're still skittish, you
can grab one of those USB header adapters that ship with MSI
and Asus boards. Plug the power switchand power LED into the
board’s front-panel connectors [image J).

JUSB1 Header

+5V 1 2 +5V
PO- 3 4 P1-

PO+ 5 6 P1+
GND 7 8 GND

Key 9 10 NC

BACK TO THE FUTURE

YOU'RE READY to turn on the Commodore 64x. If you're won-
dering where the power buttoniis, it's thered LED dome on the
right-hand side.
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1. This little fan can
getwhiny,sousea$7
Zalman Fan Mate 2 to
lower its RPMs.

2.The Zotac Fusion
ION-ITX T Series
wraps the GPU, CPU,
PSU, MOBO, and
heatsink into one
nice little attractive

package.

3. The slot-fed
optical drive can
be substituted for a
standardtraydrive or
skipped completely,
butitwouldn’tbe quite
as classy. Now if we

AN ELEGANT WEAPON FOR A MORE CIVILIZED AGE

THEORIGINAL Commodore 64 packed a 1TMHz
MOS 6510 processor, which probably has one
hundredth of the power of the CPU in your
printer. Next to that, the AMD’s E-350 "Brazos”
would appear as magic from the gods. In our
world, though, the E350 is pretty far off the
power bandasyoucanseefromourtests. The
E-350's main weaknessisits x86 performance.

The Fusion APU s fasterthanadual-core Atom
330, but beefier parts such as Intel’s Core
i5-2430M—even with the i5’s low clocks—will
leaveitinthe dust. Where the E-350in the C64x
doeswellisin 3D performance—itsintegrated
graphicssolutionhasenough powertorunolder
gamessuchas Callof Duty 4: Modern Warfare
at lower resolutions.

The real beauty of the E-350 is its low
temps. At 18 watts for CPUand GPU combined,
itreally stays cool. Inourexperience, it's far
cooler than Intel’'s own low-voltage 35-watt
dual-core Sandy Bridge chips. The E-350isn’t
aboutblistering performance, but neitheris
the Cé4x. It'sabout the cool factor of havinga
retro exteriorwithmodern computerbrains. 0)

BENCHMARKS

Model Commodore 64x Giada i50 Giada lon-100 Zbox Plus Nano XS

: 1.2GHz Intel Core 1.3GHz Intel Atom

cPU © 1.66GHz AMDE-350  © i5-430UM © 330w/ Nvidialon © 1.6GHz AMD E-450
Photoshop CS3(sec) | 445 C2m2 552 a2

MainConcept (sec) © 8,280 © 4736 © 8,858 © 4,560

3DMark 2003 © 5,685 C 1189 33 © 6,954

Quake Il (fps) - 204 Y s © 6

Quake 4 (fps) TS D 29 )

Best scores are bolded.
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Samsung Series 9
15 inches of Ultrabook goodness

AS WE LEARNED with the Acer Timeline M3
we reviewed last month, Ultrabooks are
not only growing in number, but in size.
That's the case with Samsung’s new Se-
ries 9, which comes in both 13.3- and 15-
inch flavors. We took the latter for a spin
to see how a larger footprint impacts the
overall experience.

Whereas the Timeline M3's 15-inch
chassis pushed the boundaries of ultra-
portability with the inclusion of an optical
drive and discrete graphics, the 15-inch
Samsung Series 9 offers neither amenity
and thus remains exceedingly thin, with
a profile that’s just .58 at its thickest. It's
almost a pound lighter than the M3, too,
at 3 pounds, 11 ounces.

So what does the larger size get you,
if not added features? A larger screen, of
course, along with a higher resolution.
Folks who object to the 1366x768 res of
nearly all of today’s 13-inch Ultrabooks
will appreciate that the 15-inch Series
9 ups the ante to 1600x900 (as does the
13-inch Series 9, for that matter), match-
ing just Asus’s UX31E in pixel count. Un-
like the UX31E, and all other Ultrabooks
we’'ve seen so far, the Series 9’s screen
has a matte surface, for a pleasantly
reflection-free experience. It also gets

quite bright, making it usable outdoors.
Still, it remains a TN panel like the oth-
ers, complete with the narrow viewing
angles.

The Series 9’s keyboard also benefits
from the wider footprint. The keys are
nicely sized and spaced apart for com-
fortable typing, provided you don’t mind
the shallow key press of the island key-
board. Backlighting is enabled when
ambient lighting is sufficiently dim. The
touchpad with integrated right and left
buttons is large, smooth, and generally
free of glitchiness, although multitouch
gestures can be hit or miss.

The Series 9's extreme thinness takes
a slight toll on the ports department. The
Ethernet port, for instance, is miniature,
requiring use of an included dongle. For
external display purposes, you get Micro
HDMI and a shrunken VGA port, the don-
gle for which is sold separately. But those
ports along with two USB 3.0 ports, one
USB 2.0 port, and a media reader, meet
the most common connection needs.

The Series 9 is a decent performer
for this class, although we’re curious
as to why Samsung went with the Core
i5-2467M proc when the Core i5-2557M
costs the same but has a 100MHz high-

1,200(-10.0%)

131

1,457 (-7.5%)

2,551(-7.7%)

214.2/(-1.4%)

u 47.9

339

30% 40% 50% 60% 70% 80% 90% 100%

0% 10% 20%

Our zero-point ultraportable is an Asus Zenbook UX31E with a 1.7GHz Intel Core i5-2557M, 4GB of DDR3/1333 RAM, integrated graphics,

a 128GB SSD, and Windows 7 Professional 64-bit.
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er base clock and 300MHz more Turbo
headroom. It amounts to the difference in
scores between the Series 9 and our Asus
UX31E zero-point (save for the latter’s
anomalous Photoshop score). The Series
9's 6Gb/s SSD makes for speedy sequen-
tial reads and writes (429- and 262MB/s,
respectively), but offers a paltry 128GB
of capacity. The notebook boots and re-
sumes from sleep in short order, and the
battery lasted a generous five hours and
29 minutes in our video rundown test.

Like many other Ultrabooks, the Se-
ries 9 has a unibody aluminum construc-
tion, but it eschews the brushed-metal
aesthetic in favor of matte black surfaces
accented by a polished aluminum edge.
It's a subtly handsome chassis with a
strong hinge and sturdy feel. Is it worth
its $1,500 asking price, which is on the
high-end of the Ultrabook market? It is
if you like the idea of a 15-inch ultraport-
able. -KATHERINE STEVENSON

Samsung Series 9

I COFFEE 15-inch matte

screen with 1600x900
resolution; sturdy, attractive chassis;
capable performance.

B FOUR LOKO Miniature Ethernet and VGA
ports require adapter dongles; tough
sell against the similarly spec’d but less
expensive Asus UX31E.

$1,500, www.samsung.com

SPECIFICATIONS

1.6GHz Intel Core i5-2467M

. 8GB DDR3/1333, dua[—
channel

. Intel HM65 7

. 15-inch, 1éﬂdx9DD

. Samsung 1ZéGB SSDV

. 1USB 2.0, 2 USB 3.0,7Mini
VGA, Micro HDMI, Mini
Ethernet, headphone/mic,
webcam, Bluetooth, Wi-Fi,
4-in1 media reader

3 lbs, 11.1 0z / 4 lbs, 5.2 oz




The Series 9 comes with
support for Intel's Wireless
Display, so you can wirelessly
stream 1080p content to

a larger HDTV or monitor,
provided you pony up $100 or
so for the necessary adapter.
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We hit our highest
auto-overclock
with the Gigabyte
GA-Z77X-UD5H.

777 Showdown

~

Midrange mobos square off

Not all midrange motherboards are created the same. Sure, these Z77 boards all have a black-
and-blue color scheme, and they all carry the exact same street price of $189, but differences
emerge when it comes to features, specs, and performance. Which one should you pair with your
new 22nm lvy Bridge CPU? Glad you asked. ~-GORDON MAH UNG

GIGABYTE GA-Z77X-UD5H

Of all the boards here, we're most inti-
mately familiar with Gigabyte's GA-Z77X-
UDS5H. It's the board we used for the bulk
of our Core i7-3770K testing, and one
thing we can say is that it's stable. We've
literally run more than 50 hours of bench-
marks on this board without any issue.

For a sub-$200 board, there are plenty
of features, with the most eye-catching
being a ton of USB support, including four
USB 3.0 ports plus three USB 3.0 headers.
This is done using VIA's USB 3.0 control-
lers plus the new native support from the
Intel Z77 chipset. Unfortunately, features
didn’t trump performance. The Gigabyte
was smoked by Asus’s super-secret Turbo
modes in the benchmarks.

The Gigabyte gets payback by sur-
passing the two others here in auto-
overclocking, hitting 4.5GHz and even
offering an unstable 4.68GHz setting.
The others topped out on auto at 4.2GHz.
The mSATA slot may be the board’s most
noticeable feature, though, but we're not
sure it makes sense on a full-size board.
Perhaps if it came with the SSD module;
but we don’t see any actual advantage to
it, particularly since using it disables one
SATA port.

Overall, the GA-Z77X-UD5H is a fea-
ture-richmobo forits midrange price. The
slot configuration is also nicely balanced,
with just one PCI slot instead of two. You

get far more 1/0 and higher auto-over-
clocks than with the other two boards.
Hell, it even comes with probe ports for
those of you into the overclocking sports.

"L Gigabyte GA-Z77X-UDSH

$189 street, www.gigabyte.us

ASUS P8277-V

Apparently budget board means legacy
support. That's what we inferred from
Asus’s P8Z77-V board, which has a quaint
PS/2 port and not one, but two PCl slots.
Don't think that means Asus cheaped
out on more modern amenities, though.
Although there’s no eSATA or FireWire,
Asus includes some truly compelling fea-
tures such as onboard Wi-Fi, an Intel LAN
controller, incredibly fast USB 3.0, and a
revamped Fan Xpert 2.

What's so exciting about Fan Xpert 27
Plug fans of different makes and speeds
into any of the four auxiliary fan headers
and the board will automatically measure
the minimum and maximum speed of each
fan and tune them for you with the most
advanced fan-tuning applet we've ever
seen from a board maker. If fans don’t get
you hot, consider the board’s USB Turbo

The Asus P8Z277-V
excels with bundled
Wi-Fi and impressive
USB 3.0 speed.

mode speeds, which trounce all others by
hefty margins.

Like Gigabyte, Asus pushes the Ivy
Bridge chip harder than MSI. On Turbo
with single- and multi-threaded loads,
the Asus hit 3.9GHz. The MSI board was
more conservative at 3.7GHz on most
workloads.

Overall, we give the nod to the P8Z77-V
in this roundup for its performance and
useful features, but we can see why
someone would prefer the Gigabyte for
sheer port madness and eSATA and
FireWire needs.

Asus P8Z77-V

$189 street, www.asus.com

MSI Z77A-GD65
Midrange boards typically have to sacrifice
features to get under $200 and MSI's Z77A-
GD65 shows evidence of this philosophy. It's
the only board here without a discrete USB 3.0
controller, instead relying on the native Intel
chipset for all USB 3.0. It's also the only board
without DisplayPort.

Folks still rolling PCl components will also
have to look elsewhere, as MSI ditches the
legacy expansion slot for another PCle slot.
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MSI shaved costs

by jettisoning extra
USB 3.0 ports on the
Z77A-GD65.

MSI didn't cut out all the frills, however.
The board has onboard power and reset
switches, overclocking voltage contacts, an
LED POST readout, and, like the two others BENCHMARKS
here, offers both CrossFireX and SLI as well
as LucidLogix Virtu support.

In performance, MSI takes the safe road : : :
by keeping the clocks lower than the other 3DMark 11 Overall | P6,052 | P6,308 © P6,221
two boards. At stock speeds, the board : : :
topped out at 3.7GHz on multithreaded loads : : :
and generally bounced around 3.8GHz with PCMark 7 Lightweight | 2,526 i 2,755 | 2,584
single-threaded loads. The two others here : : :

i GigabyteZ77X-UDSH Asus P8Z77-V i MSIZ77A-GD65

PCMark 7 Overall i 3,549 i 3,739 {3,603

ran full tilt at 3.9GHz on all workloads. Over- PCMark 7 Productivity gl 2610 oL
all, the performance among the trio is gen- Valve Particle (fps) ¢ 203 ¢ 208 i 190
erally close. SiSoft Sandra 2012 (GB/s) 7 213 © 2072
Like the Gigabyte, MSI's board is obvi- : H— -
ously intended for Ivy Bridge chips. Why? The SATA 6Gb/s read (MB/s) ¢ 497.9 ¢ 509.9 {4840
last x16 PCle 3.0 slot only works with an lvy - : : :
SATA 6Gb/s write (MB/s) i 2304 i 2474 i 234.0

Bridge. If you intend to run an older Sandy : : :
Bridge chip, the slot is deactivated, as SNB Native USB 3.0 read (MB/s) i 250.2 { 429.9 {2509
doesn’t have enough PCle bandwidth to run it. : : :
By sticking with PCle 2.0 from the peripheral : : :
controller hub, the Asus's third x16 is hot no Discrete USB 3.0 read (MB/s) {2432 ¢ 3245 N/A
matter which chip you run. : : :

Native USB 3.0 write MB/s) L1775 {1813 L1773

S N Discrete USB 3.0 write (MB/s) © 1781 ‘1818 CN/A
The Z77A-GD65 is a fine board at its price, : : :
butyuan foryuan, the Asus and Gigabyte sim- SLI Compliance i Yes ¢ Yes i Yes
ply outclass it in extra features and specs- - H H H
. 32GB Compliance : Yes : Yes : Yes
manship. : : :
Auto Overclock { 4.5GHz ¢ 4.2GHz ¢ 4.2GHz
MSI Z77A-GD65 Best scores are bolded. We used a Core i7-3770K, 8GB of DDR3/1866 set at DDR3/1600, a WD Raptor 150, a GeForce GTX 580, and
= 64-bit Windows 7 Professional in all of our motherboards. SATA 6Gb/s speeds were measured with CrystalDiskMark 3.01 and an OWC
. Mercury Pro SSD. USB 3.0 speeds were measured with CrystalDiskMark and a Patriot Wildfire SSD in a USB 3.0 enclosure using an
$1 89 street, www.msi.com ASMedia controller. 32GB compliance was measured with four 86B DDR3 modules.
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Asus GeForce GTX

670 DirectCU Il TOP

More power than a stock GTX 680

EVERY GPU generation has its flagship vid-
eocards: the ones with the top-of-the-line
GPU with all cores enabled, loaded for bear.
In this generation, those cards are Nvidia’'s
GTX 680 (with a full GK104 GPU inside) and
AMD’s Radeon HD 7970 (with a full Tahiti
GPU). These cards are monstrously fast,
but they're also expensive and tricky to
manufacture. Not all parts come off the line
fully functional. So a few months after each
flagship GPU launch, the vendors come out
with a slightly stripped-down version that
uses binned top-end GPUs with a few parts
disabled, or lower clock speeds. AMD’s
Radeon HD 7950 (reviewed May 2012), for
example, uses the same GPU as the 7970,
but with 28 GCN units instead of 32, and

with an 800MHz reference clock instead of
925MHz. The cheaper, lower-powered vid-
eocards appeal both to gamers with shal-
lower pockets and also to vendors, who
clock those stripped-down, less expensive
GPUs right back up to within spitting dis-
tance of their full-powered peers. Thus we
arrive at Asus’s GeForce GTX 670 DirectCU
Il TOP, a factory-overclocked GTX 670 with a
custom cooling solution.

Nvidia’s reference GeForce GTX 670 uses
the Kepler GK104 GPU with one SMX dis-
abled, reducing the total number of CUDA
coresto 1,344 from 1,536 and the number of
texture units to 112 from 128, and lowering
the base and boost clock speeds to 915MHz
and 980MHz, respectively.

BENCHMARKS

¢ Nvidia GTX 670
Reference

Sapphire
: Radeon HD
7950 0C

: EVGA GTX 680

: $430

: $400

© $500 © $400

: P9,664

: P8,706

: P9,555 : P7,683

© X3,300

i X2,957

: X3,249 : X2,562

P34,700

P32,568

P34,339 P31,752

:30.7

i 286

: 3.2 i 26.7

:19.4

: 18.5

: 18.7 : 25.8

: 89.6

: 65.5

: 73 : 53.8

: 128

;131 : 106

2167 i 16

¢ 163 : 18.7

35.4

32.4

34.3 34.1

: 57.4

: 52.7

: 547 : 453

60 57

58 54

: 1,058MHz

: 915MHz

: 1,006MHz ¢ 900MHz

: 1,137MHz

: 980MHz

: 1,058MHz : N/A

1,502MHz

1,502MHz

1,502MHz 1,250MHz

Best scores bolded. Our GPU test bed consists of a stock-clocked Intel Core i7-3960X on an Asus P9X79 Deluxe board with 16GB
DDR3/1600, a 256GB Samsung 830 Series boot SSD, and a 1050W Thermaltake Toughpower Grand PSU, in a Cosmos Il chassis. All
tests performed at 2560x1600 with all settings maxed and 4x MSAA except where noted. Power use measured with a Watts Up Pro.

B | AUG 2012

The reference GTX 670 is a dual-slot
card just over 9.5 inches long, although the
PCB is less than 7 inches long—the rest
is fan shroud. Asus, however, uses an en-
tirely custom PCB and fan shroud. The Ge-
Force GTX 670 DirectCU Il TOP, like other
DirectCU Il cards, uses direct-contact cop-
per heat pipes that feed into a stack of fins
under two 8cm fans, all in a spiffy black-
and-red shroud. Like the reference card,
the Asus board takes two 6-pin PCle power
adapters and has 2GB of GDDR5 frame buf-
fer at 3,004MHz on a 256-bit bus.

To ensure the best overclocks, Asus
cherry-picks the best GTX 670 GPUs for the
DirectCU Il TOP card. The whole assem-
blage makes the Asus card much heavier
and longer than the reference design—the
PCB alone is over 9.5 inches long, and the
fan shroud makes the card 10.5 inches
long, nearly as long as a dual-GPU card.

The extra size and weight pay off,
though. The larger fans and greater heat
dissipation area mean Asus can push
the hand-picked GPU to dizzying speeds.
Where the reference GTX 670 has a base
clock of 915MHz and a boost clock of
980MHz, Asus’s DirectCU Il TOP version
has a base clock of 1,058MHz (the same
speed as the reference GTX 680’s boost
clock) and a boost clock of 1,137MHz. Asus
includes its GPU Tweak software to allow
further user overclocking.

We tested the $430 Asus GTX 670
against a $400 reference-design GTX 670,
areference GTX 680 ($500), and a factory-
overclocked Sapphire Radeon HD 7950
($400, reviewed May 2012), its AMD equiv-
alent. As you can see in the benchmark
chart, the results are impressive.

At 2560x1600 with all settings maxed
and 4x MSAA, the stock GTX 670 outpaces a
factory-overclocked Radeon HD 7950 in all
but two benchmarks, and gives playable
(30-plus) frame rates at these settings in
every game except Metro 2033 and Shogun
2. But the impressive performance doesn’t
stop there. Thanks to those extraordinary
factory overclocks, the Asus GTX 670 Di-
rectCU Il TOP actually outperforms a ref-
erence GTX 680 across the board while be-
ing substantially cooler and quieter.

The Asus GTX 670 DirectCU Il TOP is
large and heavy, butit’s quiet, and thanks
to the cherry-picked and overclocked
processor, it's cooler and faster and has
a lower TDP than a stock-clocked GTX
680. If you want top-end performance for
less than top-end price, this is your card.
-NATHAN EDWARDS




VEADICT Asus GeForce GTX 670
DirectCU Il TOP

BITOP Faster than a GTX 680;
K!CK cool and quiet; good-looking.

|
HEE' B FLOP Longer and heavier
than the reference card; doesn’t ship with
any cables or connectors.

$430, www.asus.com

Di

réctCUIL"

o

The DirectCU Il cooler's three direct-
contact heat pipes keep the GPU cool.

maximumpc.com AUG 2012
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XFX Radeon

HD 7850

Black Edition

Outsized performance
from a midrange card

THE $250 PRICE point is where the hardcore
and the serious gamer partways. It's not that
hardcore gamers aren't serious—it’s that
they sometimes lose perspective, willing to
throw vast, silly sums of money at shiny high-
end GPUs. Serious gamers know that a good
$250 graphics card will buy you high frame
rates on standard, 1080p displays without
requiring a second mortgage.

AMD'’s original MSRP for the Radeon HD
7850 was $250, and you can find a few cards

based on the reference design at that price.
However, XFX's Black Edition version of the
card, which pushes the default 860MHz to
a factory-overclocked 975MHz, will set you
back a little more. For an extra $20, you geta
whopping 13.4 percent overclock for the core
frequency, though memory is still clocked at
the reference 1,200MHz. But the card ships
with a sizeable 2GB of 1,200MHz GDDR5, so
it's enough to run games like Shogun 2 with
all the detail levels maxed out at 1920x1200

BENCHMARKS
. XFXRadeonHD . Asus GTX 570 :S'éﬁzge:w"in XFX Radeon
;7850 { DirectCU Il it . HD 6870
Price $270 $310 $290 $240
3DMark 11 Perf " 6,075 © 5,412 . 6,153 C 4782
3DMark Vantage Perf 24,584 22,897 23,434 21,278
Unigine Heaven 2.5 (fps) 31 24 32 24
Shogun 2 (fps) 47 48 54 37
Far Cry 2/ Long (fps) - 103 02 S 97
HAWX 2 DX11 [fps) 136 101 155 129
STALKER: CoP DX11 (fps]  : 35 % @ 3
Just Cause 2 (fps) 51 W 51 4
Batman: Arkham City (fps) 60 55 61 b
Metro 2033 [fps) -2 2 2 Y
Dirt 3 (fps) 50 52 65 55
Core / Memory Clocks © 975/1,200 © 850/1,300 - 797/975 © 900/1,050
System Power @idle (W) © 118 2 BRES] 20
S AL LA 248 273 361 290

throttle (W)

Best scores are bolded. Our test bed is a 3.33GHz Core i7 3960X Extreme Edition in an Asus P9X79 Deluxe motherboard with 16GB of
Corsair DDR3/1600 and an AX1200 Corsair PSU. The QS is 64-bit Windows Ultimate. All games are run at 1920x1200 with 4x AA except
for the 3DMark tests and Shogun 2, which was run at 1920x1080, very high, no AA.

XFX's "Ghost" fan shrouds are
easy on the eyes, but they don't
vary much from card to card.

and 4x AA—not possible with the measly 1GB
frame buffer on a reference 7850.

The HD 7850 is built on a 28nm process,
with 2.8 billion transistors packing 1,024
stream processors and two geometry en-
gines. The reference board requires only one
6-pin power connector, but the XFX board
adds a second—that 13 percent overclock
doesn’t come free.

We compared the Radeon HD 7850 Black
Edition’s performance with three other fac-
tory-overclocked boards: the MSI Radeon
HD 6950, EVGA's GTX 560 Ti 448, and the
Asus GTX 560 Ti DirectCU Il. The EVGA GTX
560 Ti 448 SC card wins most of the bench-
marks—but it's $20 more than the 7850
Black Edition, bumping up close to the $300
mark and requiring an 8-pin and 6-pin power
plug. The XFX Radeon HD 7850 pretty much
wipes the floor with the Asus GTX 560 Ti and
the older, more expensive HD 6950. Also, the
XFX board is more power efficient, though a
tad noisier, than the other boards—but that
noise level isn't particularly noticeable in a
closed PC chassis.

If XFX could have shaved another $20 off
the price of this card, it would have a serious
winner on its hands. As it stands, the 7850
Black Edition is a very good card, offer-
ing good performance, efficiency, and five
display outputs—single- and dual-link DVI,
HDMI, and two DisplayPorts. Even a budget
gamer might be willing to toss in another $20
for this level of performance. -LoYD CASE

\LullSl XFX Radeon HD 7850 Black

Edition

EIAVENGERS Solid perfor-
mance; good efficiency.

B BATMAN AND ROBIN Hard to find; if it
were just $20 less....

$270, www.xfxforce.com
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SanDisk's Extreme is a plain
black metal box with a sticker
on it and speed inside.

Solid-State
Status Check

So a SandForce and an Indilinx

controller walk into a testbed...

Are SSDs approaching commodity status? There are dozens of different consumer SSDs
on the market, but with each successive generation it seems there are fewer controllers
driving them. This time around the big players are LSI's SandForce SF-2281 controller
(found in OCZ’s Vertex 3 and Agility 3 drives, Patriot's Pyro SE, Corsair’'s Force 3 and
Force GT, OWC's Mercury Extreme Pro, Intel’s 520 Series, and so many more) and Mar-
vell’s 9174, found in pretty much everything else. Samsung’'s 830 Series drives have their
own controller, but most of the rest of the market has one of two controllers, differenti-
ated only by firmware and NAND choice. Here we examine two new SSDs: one with an
off-the-shelf controller and one with a heavily modified one. -NATHAN EDWARDS

SANDISK EXTREME SSD 240GB

SSD vendors that make one or more com-
ponents of their drives tend to do better
than those who just slap commodity parts
on a board and call it a day. Sounds rea-
sonable, right? SanDisk’s Extreme SSD is
yet another drive based on the LSI Sand-
Force SF-2281 controller, a 6Gb/s SATA
SSD controller with speedy sequential
reads and an emphasis on hyper-fast
queued random writes.

However, because it is a NAND manu-
facturer, SanDisk has the means to use
its own 24nm toggle-mode NAND—eight
256Gb packages in the 240GB version—
instead of commodity NAND. Like other
SF-2281-powered drives, the Extreme
SSD uses the extra 16GB of NAND for
overprovisioning and write caching.

Contrary to its name, the Extreme
SSD isn't very extreme—at least not in
the sense of being unusual. It's a good
implementation of the SF-2281 controller
combined with high-quality NAND, so it's
not exactly rare, but that still means it's
one of the fastest consumer drives on the
planet. With sustained read speeds over
480MB/s and writes around 280MB/s, its
performance is what you'd expect from a
good SandForce drive—faster than the In-
tel 520 in reads, slower in writes. Its ran-
dom performance is classic SandForce
territory too—heavily optimized for high-

queue-depth 4KB random writes, with
over 90,000 IOPS at a queue depth of 32.
There aren’t any surprises with the
SanDisk Extreme SSD, but that's not a bad
thing. It's fast, inexpensive (just over $1/
GB at this writing), and based on a proven
platform. You really can’t go wrong.

\LLUISE sanDisk Extreme SSD 240GB

$250, www.sandisk.com

0CZ VERTEX 4 256GB

OCZ has typically reserved its Vertex la-
bel for the highest-performing SSDs in
a given generation—using synchronous
NAND, for example, rather than the asyn-
chronous NAND found in its less expen-
sive Agility series. The 256GB Vertex 4
carries on that tradition, with 16 128Gb
IMFT 25nm synchronous NAND packages
on a board with 512MB of DDR3 DRAM
cache and OCZ's new Indilinx Everest 2
controller.

It was just a few months ago that 0CZ
shipped its Octane SSD (reviewed April
2012), which was powered by the first
Indilinx Everest controller. Some dig-
ging by Anand Lal Shimpi of AnandTech.
com revealed that the Everest controller

was actually based on Marvell's 9174 con-
troller—the same one used in drives by
Plextor, Intel, Crucial, and more, but with
custom Indilinx-engineered firmware that
allowed the Octane to outperform earlier
Marvell-based drives. The Everest 2 con-
troller, while also based on a Marvell one,
is aimed even higher.

The Vertex 4's sequential reads,
at 440MB/s in CrystalDiskMark and
460MB/s in AS SSD, are impressive,
though Samsung’s 830 and any number of
SandForce-based drives hover closer to
500MB/s. Where the Vertex 4 really stands
out, though, is in its write speeds: We saw
sustained writes of over 450MB/s, which
is absurd—50 percent faster than a Sand-
Force-based SSD. We also saw great re-
sults in 4KB read and write performance,
both single-queued and heavily threaded.
Though not included in our benchmark
chart, the Vertex 4’s 64-thread 4KB ran-
dom read and write IOPS (as measured
in AS SSDJ are over 20,000 IOPS higher
than the next-fastest SSDs. Strangely,
our lometer 32QD 4KB random write test
didn’t show such a strong performance
lead. In fact, at 65,000 IOPS, the Vertex 4
was about a third slower than an SF-2281-
based drive. Our lometer test also high-
lights a potential weakness in the Everest
2 controller: Its maximum response time
during our test was a whopping 285ms.
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That’s about eight times the lag we'd see
from a SandForce-powered drive, though
only about half the 429ms maximum re-
sponse time on OCZ's Octane drive. Other
SSDs based on Marvell controller archi-
tecture also have maximum lag times in
the 100ms to 500ms range.

Its blazing-fast write performance
meant that the Vertex 4 edged out all com-
ersinour Premiere Pro test, albeit by just
a few seconds. In PCMark Vantage and
7's storage suites, the Vertex 4 doesn’t do
quite as well as a SandForce drive, but the
differences are minimal.

With an MSRP of $350, the 256GB
Vertex 4 isn’t as inexpensive as a 240GB
SandForce-based SSD, but it's already
under $300 on the street, which is push-
ing close to the magical dollar-per-
gigabyte price point. Frankly we can't
believe how far SSDs have come in the
past year alone.

The Vertex 4's write speeds are truly
astounding, and the read speeds are noth-
ing to scoff at, either. We're happy to see
0OCZ forging its own path with the Ever-
est 2 controller. Even if it's not, strictly
speaking, new silicon, the magic firmware
sauce is working here.

0CZ Vertex 4 256GB

$350, www.ocztechnology.com

The Everest 2 controller in the
Vertex 4 is a modified Marvell

controller with custom Indilinx
firmware.

i 5,282

i 5171

4,945

BENCHMARKS
SanDisk H H . Samsung
: Extreme : OCZVertex4 : :me Pyro H gCtZ : 830 Series
i ssD : : ot gep
Capacity ¢ 2406B ¢ 2566B ¢ 2406B ¢ 51268 © 2566B
CrystalDiskMark
Sustained Read (MB/s) | 479.1 © 4409 {482 {4454 | 506.4
Sustained Write (MB/s) | 283.7 \ 4469 ¢ 3003 {3155 | 3985
AS SSD
Seq. Read (MB/s) | 503.8 s {5067 {4322 {5026
Seq. Write (MB/s) ‘278 {4593 {2952 | 285.9 © 1641
4KB Read (10PS) ¢ 5,029 {6,632 ¢ 4,986 | 5546 | 5513
4KB Write (10PS) 15,244 ¢ 17,169 14,179 £ 10417 1 12,800
ATTO
64KB File Read [MB/s) : 490.3 ¢ 396.7 © 443.24 ¢ 408.57 © 405.85
64KB File Write (MB/s) © 441.3 4704 ¢ 487.9 ¢ 287.02 { 515.05
lometer
4KB Random Write ¢ 90,060.8 { 65111.06  © 91,171.26 | 22,073.97 . 35329.48
Max Access Time ms) 30 ¢ 285 § il © 429 f 3
ALUCIAEALIDES a7 424 ‘425 ‘420
Write (sec) H H H H H
:E’;”kv"'ag”“ | 58,366 ¢ 41568 ¢ 61,686 57,030 62,168
PCMark 11 x64 SST i 5,305

i 5,257

Best scores are bolded. Our current test bed is a 3.1GHz Core i3-2100 processor on an Asus P8 P67 Pro (B3 chipset) running Windows
7 Professional 64-bit. All tests used onboard 6Gb/s SATA ports with latest Intel drivers.
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Zotac ZBox Nano
XS ADM Plus

Small just got smaller

THE BIGGEST thing about Zotac's new
ZBox Nano XS AD11 Plus may in fact be
its name. This new mini PC is so small,
it makes the diminutive ZBox Nano AD10
look positively fat in comparison.

Hell, the only commercial mini PC
we’'ve seen that’s smaller is the Apple TV,
which is about the same width and depth
but a quarter-inch thinner. The Apple TV
is ARM-based, though, and more in the
class of a typical HTPC streaming device.
The AD11, with its AMD E-450 APU and
64GB SSD is a full-on PC. While stream-
ing boxes such as WD’s Live have come a
long way in capability, it's tough to beat
a PC’s ability to go anywhere you want.
From streaming sites that are restricted
by cable providers to not-safe-for-work
content, an HTPC streaming PC trumps
all others if you're willing to live with a
mouse and keyboard controls.

The ZBox Nano XS AD11 Plus has two
parts that can be swapped: the 64GB
mSATA drive and a single 2GB DDR3/1333
SO-DIMM (both of which are easily ac-
cessible). Performance of the new AMD
E-450 was surprisingly good in our tests.
The APU’s main new feature is a slight

SPECIFICATIONS

AMD 1.65GHz E-450 dual-core
. Radeon HD 6320 7
. 64GB Lite—OnrmSATA
. 2GB DDR3/1353 swnglefchénnel

HDMI, two USB 2.0, two USB 3.0,
one combo eSATA/USB 2.0

B | AUG 2012

speed bump to its dual CPU cores and
higher Turbo clocks for the Radeon HD
6320 core. Performance is only a small
factor in an HTPC, but if you want to see
the benchies, check out page 65, where
we compare the ZBox Nano XS AD11 Plus
to this month’s Build It rig. In short, the
Nano XS AD11 has enough oomph to let us
watch streaming HD content on the major
streaming services and it could almost
tackle that turd known as QuickTime,
playing a 1080p trailer from the local
drive without dropping frames. For what
it's worth, the file plays just fine from
Windows Media Player.

Our only negative experience with
the AD11 was getting all of the driv-
ers installed. You shouldn’t have to
play Where’'s Waldo to accomplish

this task, but we had to. There's also
a tad bit of fan whine under heavier
loads and the USB Wi-Fi fan dongle is
uninspired but practical. That doesn’t
erase the pluses, though. The AD11 is
impressively small and capable for
what it is. -GORDON MAH UNG

ZBox Nano XS AD11 Plus

B ROCKY Small enough to tuck
anywhere; has enough power to
stream most content.

EIVAN DRAGO Slight fan noise and under-
whelming driver-install process.

$360, www.zotac.com

Zotac's ZBox Nano
XS AD11 Plus

is the smallest
commercial PC
we've ever tested.
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D-Link
DIR-857

HD Media
Router 3000

802.11n's last gasp?

IN CASE YOU'RE wondering why we're review-
ing an 802.11n router when the first 802.11ac
routers have already reached the market, we
have several reasons. First and foremost,
the latter didn't make it to the Lab in time for
our print deadline. Secondly, the IEEE isn't
expected to formally ratify the 802.11ac stan-
dard until early 2013. The 802.11ac routers on
the market today are based on Draft 2.0 of the
standard, so there’s a remote chance they
could be rendered obsolete when the stan-
dard s finalized.

D-Link has been oddly quiet about its plans
for 802.11ac, but we're guessing the DIR-857
will likely be the company’s last consumer-
oriented 802.11n model. The DIR-857 is
housed in the same low-profile enclosure
as the less-expensive DIR-827 we reviewed
in May 2012, with a 3x3 antenna array hidden
inside and just two discrete status LEDs on
top. We understand the “spouse acceptance
factor,” which requires consumer electronics
hardware to be designed to disappear into a
home's décorin order to be acceptable to your
non-geek significant other, but a flat router
with internal antennas just isn't going to per-
form as well as a vertical model even if they
both have internal antennas. Pit one of those
against any model with external antennas,

such as the Asus RT-N66U, and it will fare
even more poorly.

That's certainly what we found when we
compared the DIR-857 to the RT-N66U: The
Asus router, with its semi-vertical orientation
and its positional external antennas, crushed
the D-Link both in terms of wireless through-
put and range. When the client was set up in
our acoustically isolated home theater, the
RT-N66U delivered more than three times
as much throughput, guaranteeing that we'd
be able to stream high-definition video to our
HDTV without wires. And where the D-Link
was barely able to reach the client at our
outdoor location, 85 feet from the router, the
Asus delivered enough throughput that we’'d
have no trouble streaming HD video there, too
(at least on the 2.4GHz band. The RT-N66U’s
throughput dropped to 3.9Mb/s on the 5GHz
band, but the DIR-857 wasn't able to connect
at that location at all at 5GHz).

Since media streaming is such animportant
application for wireless routers, we've added a
new test to our benchmarking suite: We mount
a Blu-ray disc image on our notebook PC
(from an .iso file stored on our Windows Home
Server 2011 machine), and we stream that file
acrossthe wireless network. Atthe sametime,
we download a large file from the Internet to

WIRELESS BENCHMARKS

2.4GHz Band 5GHz Band

D-Link Asus D-Link Asus

DIR-857 RT-N66U DIR-857 RT-N66U
Bedroom 1, 10 feet (Mb/s) 112.0 141.0 124.0 152.0
Kitchen, 20 feet (Mb/s) 73.7 133.0 93.2 129.0
Patio, 38 feet (Mb/s) 65.3 110.0 56.7 64.1
:';:;:]Them" 35 feet 2.6 77.7 5.2 30.1
Outdoors, 85 feet (Mb/s) 2.7 50.3 N/C 3.9

a second wireless client. Neither router had a
problem fulfilling that task at a distance of 45
feet from the router, with an insulated wall,
wooden cabinets, and several stainless steel
appliances (a refrigerator, a built-in double
oven, and a range] in the signal path.

Despite the DIR-857's performance com-
ing up short compared to our new zero-point,
we still think it's a very good router. It boasts a
rich feature set, including two USB 3.0 ports
that made for very fast NAS-to-PC file trans-
fers (it fell far behind the RT-N64U, however,
when it came to PC-to-NAS transfers), ithas a
handy built-in SD card reader, and—as is typi-
cal of D-Link routers—it's equipped with ex-
cellent Quality of Service settings. It's just not
as good as Asus’s RT-N66U. -MICHAEL BROWN

\SLLIES D-Link DIR-857 HD Media

Router 3000

BIPA Excellent QoS features;
SD card reader; dual USB 3.0 ports.

EHEFEWEIZEN Relatively short range, es-
pecially on the 5GHz band; slow write-to-
NAS speed.

$180 street, www.dlink.com

WIRED BENCHMARKS

D-Link Asus

DIR-857 RT-N66U
TCP Throughput (Mb/s) 945.0 943.0
PCto NAS, small (sec) 78.3 46.0
PC to NAS, large [sec) 333.0 161.7
NAS to PC, small (sec) 49.7 81.3
NAS to PC, large [sec) 163.7 280.7

Best scores are bolded. TCP throughput measured using JPerf. NAS tests consist of copying a single 2.79GB file and a folder containing 659MB worth of files and folders to and from a USB

3.0 drive attached to the router. N/C indicates no connection at that location. Additional benchmarking methodology at bit.ly/r5USfH.
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Yes, there are 802.11ac
routers on the market, but
they're based on Draft 2.0
of the standard, and the
Wi-Fi Alliance did not have
a certification program in
place at press time.
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Nokia Lumia 900

Makes a strong case for
Windows Phone platform

the white flag in retreat from
American shores against an invasion of i0S
and Android smartphones, Nokia has re-
grouped with the Lumia 900. Now strategic
allies with Microsoft’s Windows Phone and
carrier AT&T, can Nokia stage a comeback
and reclaim lost ground?

Nokia has outdone itself with this stylish
5.03x2.7x0.45-inch wide slab, which weighs
just 5.6 ounces. It's one of the best-looking
smartphones we've ever seen. The Lumia
900 features a classy unibody frame made
from polycarbonate. It's tough and feels ab-
solutely wonderful when held in your hand.

The front of the Lumia 900 is primar-
ily a 4.3-inch capacitive touchscreen with an
800x480 resolution. While this can be a stick-
ing point in the age of high-resolution “Ret-
ina” displays, the screen is bright, colorful,
and pixel-dense enough for all but the most
discerning users.

Three capacitive Windows Phone but-
tons sit below the display for Back, Start, and
Search. All the physical buttons—volume
rocker, power/lock, and camera button—re-
side on the right, an arrangement that’s quite
comfortable in use whether the phone is held
in the right or left hand.

The Lumia 900 features a IMP camera on
the front for video chat and an 8MP camera
on the back. The 8MP camera shoots 4:3 im-
ages up to 3264x2448 pixels, but options are
available in settings for 7MP 16:9, 3MP 4:3,
and 2MP 16:9, as well. Focus can be switched
from Normal to Macro and basic effects can
be applied while shooting (Black & White, Se-

alc

Display 4.3-inch, 800x480, AMOLED

Cameras

Li-ion 1,850mAh

Dimensions 5.03x2.7x0.45 inches, 5.6 oz.

AUG 2012

pia, Negative, or Solarize). Contrast and color
saturation are above average in most cases,
and the Lumia 900 is capable of quite decent
outdoor images when the sun is cooperating.
We were less enthusiastic about our results
shooting indoors, and the dual-LED flash
didn’t do us any favors, either, producing gar-
ish results and a lot of red eye. Results are
also quite mixed once you switch the Lumia
900 camera into camcorder mode. With most
modern smartphones now recording 1080p
HD video, Nokia’s newest flagship device
appears to bring a knife to a gunfight—it's
capable of only 720p HD at 30fps (a less-de-
sirable secondary mode is also available for
640x480 video).

The Lumia 900 runs on a humble single-
core Qualcomm APQ8055 + MDM9200 pro-
cessor clocked at 1.4GHz with a mere 512MB
of SDRAM, but don’t let the numbers fool
you—we were able to flick, tap, and swipe
our way through each day without notice-
able lag.

AT&T is offering the Nokia Lumia 900
with a modest 16GB of storage for a wallet-
friendly $100 with a two-year agreement,
but only for a limited time; existing custom-
ers can upgrade for a bit more or purchase
no-commitment for $450. The big story with
AT&T’s launch of the Nokia Lumia 900 is 4G
LTE. Unfortunately, for the Lumia 900 launch
this service is limited to less than 35 cities
right now. We had no problem connecting
to AT&T’s other 4G network—as in its “faux
G” HSPA+ wireless capable of up to 21Mb/s
download speeds. We didn’t hit anywhere

near that maximum while testing with the
free BandWidth app, but we did hit a respect-
able 7.05Mb/s download (upload speeds
were sadly under 1Mb/s). These are compa-
rable to what we've seen on an iPhone 4S on
AT&T, too.

As for the 0S, Windows Phone 7.5 remains
enjoyable for its refreshingly different tile-
centric interface and smooth experience.
The biggest downfalls are the relatively
paltry app store—currently at 70,000 offer-
ings—and the use of the mobile Internet Ex-
plorer 9 for its browser. Render speeds were
noticeably slower with IE9, and fonts looked
downright chunky when finished. Microsoft
does bring one very large bat to this game,
however, with the only authentic mobile ver-
sion of Office. Users can view, create, or edit
Word, Excel, and PowerPoint documents as
well as OneNote notes on the go and access
them from onboard storage, SkyDrive, Of-
fice 365, or SharePoint. The app works well,
but as usual, making changes to an Excel
spreadsheet even on a 4.3-inch display is an
exercise in patience.

Nokia has favored form over function wi
the Lumia 900, which includes a sealed, no
removable 1830mAh battery. Nokia pr
ises up to seven hours of 26/3G talk time
more than 12 days of standby time, but
figures will vary wildly depending o
many apps you choose to run in the
ground. We had no problem getting
an entire day with frequent use on bo
b/g/n and HSPA+ networks, but your
will certainly vary in a 4G LTE market.

If Microsoft and Nokia can tighten up
the 0S, beef up the Marketplace selec-
tion, and slap in a better camera, they’'ll
have a real shot at dethroning one or both
smartphone giants. Until then, the Lumia
900 may not be perfect, but it's plenty
good enough to recommend with little
hesitation for users looking ahead to The
Next Big Thing. -J.R. BOOKWALTER

Al Nokia Lumia 900

BILTE Solid, attractive build;
Windows Phone 7; strong app
bundle.

B HSPA+ 16GB storage; mediocre camera;
paltry Marketplace.

$100 w/ 2-yr contract, $450 w/o
contract, www.nokia.com




The polycarbonate body is a pleasure
to hold, and the AMOLED screen is
bright and colorful.
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Each 15-pound cabinet houses a
20-watt Class D amp driving a 1-inch
silk-dome tweeter and a 4.5-inch
woven-fiberglass woofer.

Aperion

Audio Zona

Wireless
Speaker
System

Close enough for jazz

THE PERFORMANCE of Aperion Audio’s
Zona speakers is good enough for us to
grant the company poetic license in la-
beling these speakers “wireless.” They'd
need to be battery-powered in order to be
entirely free from wires, an impractical
solution because those batteries would
need to be humongous to power the 20-
watt Class D amplifier in each cabinet.

As it stands, each speaker requires a
hefty power brick plugged into a power
outlet to function (the electrical cables
are quite long—17.5 feet—to reach distant
outlets). The wireless element comes in
the form of a small puck with a USB cable
and a 1/8-inch stereo input. Plug the puck
into your PC’s USB port, and it becomes a
USB audio device that takes the comput-
er’s PCM audio output and streams it to
wireless receivers built into the speakers.
The PC powers the puck’s wireless trans-
mitter. The Zona is also a great solution
for folks who'd like to deploy surround-
sound speakers, but can't stomach the
idea of stringing speaker cable to the back
of the room. In this scenario, you'll con-
nect your A/V receiver’s analog pre-amp
surround channels to the puck’s audio
input, and plug its USB cable into the pro-
vided AC adapter. Aperion provides all the
cables you'll need.

The wireless transmitter and receivers
operate on the 2.4GHz frequency band,
but we didn't encounter any interference
issues even though we have one wireless
router and two Wi-Fi access points oper-
ating in the house we tested them in (and
one of the APs was less than six feet away
from the Zona's transmitter). According
to Aperion, the system sends an uncom-
pressed bit stream with 16-bit resolution
at a sampling rate of 48kHz. That's more
than adequate for tracks ripped from
CD, but you will lose some fidelity when
streaming 24-bit FLAC files or Blu-ray
movie soundtracks. We also detected a
very small amount of background hiss in
the absence of any other audio signal, but
only when we put our ear directly against
the speaker’s grill. If those shortcomings
bother you, stick with a wired solution.

Aperion claims the system is capable
of 100-foot range, but they're probably
not factoring in any walls obstructing the
signal path. In our experience, we were
able to stream audio from the HTPC in
our room-within-a-room home theater
to any other room in our 2,700-square-
foot house, but we encountered audible
dropouts at the fringes when we blocked a
speaker with our body. Perhaps more im-
portantly, we didn’t detect any audible lag

when we set up the speakers as surround
channels within our home theater.

Listening to Cara Dillon’s rendition of
the Irish folk song “The Parting Glass,”
from the Bowers & Wilkins' release Live
at the Grand Opera House (encoded in 24-
bit FLAC at a 48kHz sampling rate], it was
easy to forget that the music was stream-
ing over the airwaves. The speakers deliv-
ered a solid performance with crisp highs
and a fat bottom end; and while the loss in
fidelity from down-sampling was notice-
able, it wasn’t particularly irksome. Given
the choice, we’ll always take the no-com-
promises wired solution. But if that's not
an option for you, Aperion Audio offers an
excellent alternative in the Zona Wireless
Speaker System. -MICHAEL BROWN

\LLLIEU Aperion Audio Zona Wireless

Speaker System

EIIN THE ZONE Very good
sound; uncompressed wireless stream-
ing; can be mounted.

EIZONED OUT You’'ll need to hide the
large power bricks; range shorter than
advertised.

$400, www.aperionaudio.com
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Cooler Master

TPC 812

Vertical vapor chamber—
blowing hot air?

WE HAVE BEEN anxious to test Cooler
Master’'s TPC 812 since we saw a pro-
totype at this year’'s CES—or was it
last year's? Regardless, the company
piqued our interest with its talk of
“vertical vapor chamber cooling,” and
we finally have our hands on the TPC
812, a massive air cooler with six heat
pipes and two vertical vapor cham-
bers.

The TPC 812 is 6.4 inches high, 4.1
inches deep (with fan), and 5.4 inches
wide, and weighs over two pounds,
four ounces. Unlike Cooler Master’s
wildly successful Hyper 212 cool-
ers, the TPC 812 doesn’t have direct-
contact heat pipes. Or direct-contact
vapor chambers. Instead, its six heat
pipes are soldered to the (nickel-coat-
ed) copper heatsink, and the bottoms
of the vapor chambers rest atop the
heat pipes. The heat pipes and vapor
chambers rise through a large stack of
aluminum fins. The TPC 812 ships with
one 12cm PWM fan with a set of plastic
mounting clips, beefier versions of the
ones that ship with the Hyper 212 Evo
(April 2012), as well as a set of clips for
attaching an additional fan. The cooler
also ships with a resistor cable if you
prefer to run your fan at lower rpms,
which you might, given its noise at full
throttle.

The TPC 812 mounts to the mother-
board with the same sort of mounting
bracket we've seen on the Hyper 212
series coolers: an X-shaped crossbar
with spring-screws at the ends, which
mounts to four posts in the mother-
board’s cooler mounting holes. The
posts are either screwed directly into
the integrated backplate (LGA2011) or
into a universal backplate (all other
sockets].

The TPC 812 cooled our overclocked
i7-3960X to 71.2 C—47.2 C above the 24
C ambient temperature in the room.
By contrast, the Xigmatek Aegir, our
champion at this price/size range, got
the CPU down to 69.2Cina25.6 Croom
(43.6 C differencel, and the CM Hyper
212 Evo, our favorite budget cooler, got
the CPU to 70.2 C while the room was
25.7 C (44.5 C difference). The TPC 812
isn’t a bad cooler—its performance is
still impressive. It's just not enough
to dethrone the Hyper 212 Evo or the
Xigmatek Aegir. Both, incidentally, are
direct-contact coolers, and the Evo is
half the price of the TPC 812.

We're not sure why Cooler Master
chose to use vapor chambers at all on
this cooler, given that a vapor chamber
is essentially a wide, flat heat pipe.
They're useful in space-constrained
applications like videocards, but the
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Those massive heat pipes protruding
from the top of the cooler? They're
decorative caps, sitting on the real (and
smaller) heat pipes.

TPC 812 hardly has that problem, and
putting vapor chambers atop the six
heat pipes the cooler already has feels
like an afterthought, or a gimmick.

Given that this is the only verti-
cal vapor chamber cooler we've
tested, we're not ready to dismiss
the technology outright, and the
TPC 812 is a fine cooler, but com-
pared to cheaper, lighter direct-con-
tact coolers, the TPC 812 can’'t win.
-NATHAN EDWARDS

\LLLIS Cooler Master TPC 812

EICHAMBER OF SECRETS Good
looks; relatively easy install;
decent performance.

B BLACK CHAMBER Performance lags be-
hind best-in-class, which are smaller and
cheaper; noisy fan.

$70, www.coolermaster-usa.com

SPECIFICATIONS

BENCHMARKS

Dimensions H x D x 6.4x41x5.4

Heat Pipes

6, plus two vertical

vapor chambers

Add’L Fan Support 1 (plastic clips
included)

i CMTPC812

Xigmatek Aegir

All temperatures
in degrees
Celsius. Best

{ CM Hyper 212
: Evo

Ambient Air P i 2546

scores bolded. All
H tests performed
HIR25N7, using an Intel
Core i7-3960X

Idle Temperature 32.3 34.2

H at 4.2GHz, on an
: 342 Asus Sabertooth
; X79 motherboard

Burn Temperature 71.2 69.2

H with 16GB
: 70.2 DDR3/1600, in a
; Thermaltake Level

AT (Burn-Ambient) 47.2 43.6

: 10 GT with stock
: 44.5 fans set to Low.
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Diablo Il

This took 11 years?

LIKE MANY OF THE one-sided NPCs that
appear within Blizzard’s third summer-
vacation-to-Hell, it sure feels as if there’s
something special lurking beneath Dia-
blo Ill—once you get behind all the odd
trappings and poor design decisions, that
is. If you're new to the series, the game
goes something like this: See evil, click
on evil, kill evil. Repeat 100,000 times.
That’s Diablo.

Diablo Il beautifies this formula by
combining artistic flair with rote game-
play. Spell effects and weapons glow or
boom with real pizzazz, and the environ-
ments—though not as gritty asin the orig-
inal Diablo—are themed with more eye
candy and interaction than ever before.
That includes everything from the gross,
blood-spurting torture instruments that
you can shatter in the Halls of Agony, to
the giant chained demons “looking” up at
you in the background of the Tower of the
Damned, to the epic human-on-demon
fighting you see on the ground (and even-

K | AUG 2012

tually participate in) while fighting atop
Bastion's Keep.

While the game still features a bit of
the genre’s “evil stands around and waits
for us to kill it” motif, Blizzard's done a
great job of incorporating more surprise
into Hell's troop deployments. Baddies
scale walls, “Demonic Hell Bearers”
surge over walls, Dune-like sandworms
pop through the ground to say hello, and
demons fly with bullet-like speed up into
Heaven itself (and then start swinging).
Blizzard's creative use of the environment
adds more depth and realism than any-
thing you've ever seen in the Diablo series
to date; we smile each time we get to cut
a chandelier cord and wonk a skeleton in
the noggin’.

A special kudos to Blizzard for mak-
ing Diablo Il the most challenging of the
Diablo games. There are plenty of times
when a seemingly normal situation turns
into a “mash all the buttons” encounter
of deadly proportions. This is not a game

where you'll be able to clean up every
trash mob until the boss without break-
ing a sweat. Painful, randomized affixes
added to the game’s elite mobs can ruin
your day, but so can the normal baddies
if you're not thinking strategically about
how you might fight them. Gamers will
grow a great hatred in their hearts for
the (damned] Sand Wasps of Act Il truly,
Blizzard’s most insidious creation and the
grand masons of many a hardcore char-
acter’s tombstone.

However, one of the big issues plagu-
ing Diablo Il is that the game’s difficulty
doesn’t scale all that well—at least, not
in the correct way. The game’s boss en-
counters are inconsistent, ranging from
painfully simple encounters to semi-
strategic fights that exemplify World of
Warcraft's first rule: Don't stand in the
glowing stuff. That's all well and good, but
it's not all that innovative. Even when done
well, Blizzard’s treatment of its major bad
guys (and gals) still doesn’t feel all that
creative compared to the fight mechanics
of Diablo’'s MMO cousin. Diablo Ill needs
more depth.

Acrossthe game’s four difficulty levels,
Blizzard generally makes Diablo Il harder
by increasing enemy hit points and dam-
age, not by forcing the player to outthink
mobs or bosses. The actual mechanics of
the final Diablo fight are identical on the
game’s hardest difficulty and its easiest:



Diablo Ill's dialogue is so
gripping you wish you could
roll a pair of earplugs.

It'lL just take you a lot longer on “Inferno,”
hurt a lot more, and you'll be frustrated as
all heck when you're unfairly one-shotted
by the game’s many mobs along the way.

“But wait,” you say, “Diablo llI's skill
system means you can pick the perfect
combination of six spells on-the-fly to
manage any battle!”

True. But Blizzard's approach doesn’t
expand your ability to customize your
character; it limits it. A specific range
of spells and gear gives a player enough
survivability to perform the ultimate ex-
ploit on the game’s highest difficulty: Kit-
ing super-charged bad guys around in a
circle and killing them slowly over time.
That’s not using a range of spells or cre-
ative character builds strategically to
dodge, reflect, resist, or otherwise par-
ticipate in what we'd call “active combat.”
It's a passive and downright boring tech-
nique players have to use against enemies
who can obliterate them with a single hit.

Blizzard has transformed its difficulty
settings into gear checks, not engag-
ing challenges that can be surpassed by
a mastery of technique. Harder difficul-
ties should make monsters smarter and
showcase new and exciting boss mechan-
ics players haven't seen before. Don't just
give each demon a Golden Gun.

“Shut up and gear up,” some might re-
tort. Well, Blizzard's made that surpris-
ingly easy with Diablo IlI's new in-game

The early demonic bird gets the
hapless defender.

auction house, which does a great disser-
vice to the entire premise of the Diablo se-
ries. Part of the joy of Diablo II's end game
came from going on countless “boss
runs” to acquire better gear. If you were
unlucky, however, you had to take the un-
wanted gear you picked up and trade it
away to your peers for better loot.

In contrast, Diablo IlI's auction house
hurts the game’s replay value. Why both-
er running levels over and over to hunt
for new gear when you can just take all
the gold you picked up and buy the per-
fect item you're looking for? There's no
need to use the game’s “Jeweler” craft-
ing NPC when you can spend less gold to
buy better gems from players; same for
the Blacksmith NPC. Why create items
with random stats when you can buy ex-
actly what you want from the millions of
players selling? And don’t get me started
on Diablo Ill's general itemization. At the
time of this review, blues (magic weapons,
easily found) can offer better stats for
your end-game character than Blizzard's
super-unique Legendary items. Huh?

You can’t take much solace in Diablo
I1's woeful story. The Diablo series isn’t
exactly War and Peace, but the plot ele-
ments within Diablo IlI's acts feel more
like short vignettes than a truly con-
nected through line. It's hard to feel
much of an emotional connection from
the game’s laughably poor dialogue and

Oh, had one
a nickel for
every time
a demon

or angel
calls you

“Nephalem”
while shaking
its head in
disapproval...

dreadful story arcs, and the obviousness
of Diablo’s “intricate” plot is as transpar-
ent as an archangel’s energy wing ten-
tacle-things. As for why Blizzard made
The Butcher the end boss of Act One—a
throwaway homage to its first game that
has no connection to the plot whatsoev-
er—has us scratching our heads.

The silly decisions continue. It makes
no sense why Hell's greatest planner
whines more than schemes; why an
arch-mage whose entire storyline cen-
ters on his immortality turns into one of
the easiest boss fights in the game [some
invulnerability); and why Diablo itself
somehow feels the need to taunt you like
a playground bully every time you kill one
of his friends. The “Lord of Terror” was a
lot creepier when he threatened you with
death the first (and last) time you saw him
in previous titles. Pouty Diablo is a joke.

If we sound mad, we're not. The core
mechanics of Diablo Il truly are fun. You
will enjoy leveling up, swapping skills
left and right, and shooting demons with
reckless abandon. The game is pretty on
the eyes (especially those jaw-dropping
cutscenes), fairly interactive, and much
faster-paced and friend-focused than Di-
ablo Il. But the hard truths remain: For a
game that sat in development for so long,
Blizzard’s tunnel vision seems to have
significantly affected its ability to trans-
form a pretty good romp into Hell into a
legendary sequel. It's a shame, too; what
gamer wants to wait 10 more years for a
better Diablo IV? -DAVID MURPHY

Diablo Il

B WIRT THE PEG-LEGGED BOY
Addictive gameplay, beautiful
graphics, and challenging scenarios will
keep you thinkin” and clickin’ for a while.

EGHARBAD THE WEAK Poor plot decisions,
ill-conceived enemy mechanics, and the
dreadful auction house cheapen Diablo’s
raison d'étre.

$60, www.diablo3.com, ESRB: M

maximumpc.com AUG 2012

o | 89



in the lab| -

[ABINOIRES

ALEX CASTLE ONLINE MANAGING EDITOR

SADLY, THIS ISSUE is my last as a full-time editor at the Maximum PC
offices in San Francisco. Don’t shed too many tears for me, though;
I'm now living in (and will be contributing to the magazine and website
from) Hawai'i, the nation’s southernmost and most island-ular state.

Since announcing this fact on the website, a lot of people have
asked why an online editor even needs to be in the office. The fact
is, even with all the advances in telepresence tech, there are still
things that make remote work impractical. Working in different
time zones can be a pain, as is shipping products for review and
dealing with state tax law. But the most important thing is that
making a magazine is a complicated business, and not having all
the moving pieces in the same location only makes it more com-
plicated. I'll miss being a staffer at Maximum PC, but | can’t wait to
see what great stuff the magazine has in store.

Editor leaves Lab for island paradise

It's Not Goodbye,

Gordon Mah Ung
Deputy Editor

Katherine Stevenson
Editor-in-Chief

| know dual-core desktop
Ivy Bridge chips will bring
the power down to as low as
35 watts, but I'd actually like
to see a resurgence of even
lower-wattage builds using
mobile chips. That 35 watts
would net you a quad-core
instead of a dual-core if a
mobile Ivy Bridge chip was
used, and a dual-core can
take you as low as 17 watts.

Can an 11-inch notebook de-
liver a kick-ass gaming ex-
perience? | was pleasantly
surprised with the oomph in
Alienware’s M11x a couple of
years back, but Dell has since
eliminated that small form
factor from its lineup, pre-
sumably due to lack of sales.
Nevertheless, other vendors
are stepping into the 11-inch
gaming-notebook fray, and
I'll be reviewing one of those
portable powerhouses next
month.

Nathan Edwards
Senior Editor

I've gotten some flak over
starting our Blueprints sec-
tion with a $1,300 rig. Af-
ter all, a console is $300
and we've built plenty of
decent sub-$1,000 gaming
machines. My original ra-
tionale was that “Baseline”
really means “the base
power-user PC we'd be
absolutely proud to recom-
mend.” But should we have
a sub-$1,000 Blueprints
build too? Let me know at
nathan@maximumpc.com.

Richard Koscher
Art Director

My recent trip to the WPA
Maggie Awards in Los An-
geles was a successful one.
Not only did Maximum PC pick
up an award for Best Special
Interest Magazine, but it also
took the grand prize for Best
Overall Consumer Magazine
from a crowd of 1,400 en-
tries. The judges based their
decision on our September
2011 Dream Machine issue.
It's great to be recognized by
the leaders of the publishing
industry for all the hard work
we pour into our magazine.
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Too Many Upgrades,
and AMD

First, can and will the heads
of the computer industry
agree to release upgrades
as a platform instead of the
randomness seen today?
Meaning, will they agree to
release USB 4.0 or SATA 4.0
only when PCIE 4.0 and DDR4
are ready to go? Second, from
what | have read, Bulldozer is
an inferior-performing chip.
AMD promises better per-
formance on Windows 8, but
what if that doesn’t happen?
Since AMD already had to lay
off workers, will Bulldozer
spell the end of the company
or at the very least its desk-
top chips? If AMD is forced to

—> In our July issue LCD
roundup, we used the wrong
picture to illustrate the Sam-
sung Series 5 T27A550. The
correct model is pictured
here.

- Two of the zero-point
scores in the benchmark
chart for the Origin PC Chro-
nos (June 2012) were incor-
rect. The Chronos was actu-
ally 11 percent faster than our
zero-point in Vegas Pro, and
just 2 percent slower than our
zero-point in STALKER: CoP.

WE TACKLE TOUGH READER QUESTIONS ON...

> Random Upgrades
> AHCI Hack
> Cyborg Cases

close, will IBM make a grab
at it and re-enter the desktop
market?

—Brad Davis

DEPUTY EDITOR GORDON MAH
UNG RESPONDS: The main
problem with your first ques-
tion involves the differing
cadences of each technology.
It would actually hurt the
industry as a whole, not to
mention performance, if each
different technology had to
wait for another before it
could launch. This doesn’t
mean synchronicity doesn’t
happen, though. Sometimes
new technology launches are
so close they intentionally
sync up to reduce the pain

CUT, COPY, PASTE

of adoption and to make an
upgrade sweeter. Another
problem with so many differ-
ent technologies launching at
once is that oftentimes there
is so much money at stake in
a spec and so much politics
that it takes months just to
agree on the shape of the
table to meet around.

As for Bulldozer, perfor-
mance on Windows 8 will
likely get better, but not
magically faster than Intel’s
parts. That doesn’t spell the
end of the company, however.
AMD is seeing good success
with its integrated Brazos,
Llano, and Trinity parts.
AMD'’s future never hinged
solely on Bulldozer beating
Intel’s parts in performance.
And no, IBM is unlikely to
ever get back into the desk-
top market making tradi-
tional x86 PCs.

Let's Be Real about
Mobile Gaming

| recently read Alex Castle’s
“PlayStation Vita vs. iPhone
4S”.in the Head to Head
section (June 2012) and
came away a bit confused.
At the end, he declares the
Vita the winner, stating, “the
PlayStation Vita is simply
the best way to play real,
high-quality games while
you're away from home.” |

must have missed the memo
that declared Minecraft,
Need for Speed, Dead Space,
RAGE, Doom, Mass Effect,
Sonic, Soul Calibur, and Final
Fantasy [among many, many
others) as not being “real”
games. You learn something
new every day.

—Ed Piotrowski

ONLINE MANAGING EDITOR
ALEX CASTLE RESPONDS:
Having played nearly all the
games you've mentioned, |
have to assume that either
you have not, or that you're
being deceptive to make a
point. Although all the titles
mentioned share a name with
classic gaming franchises,
none of them is the type of
gameplay experience nor-
mally associated with games
from their brand. Need

for Speed is probably the
closest, but it still lacks the
depth of a full NFS game (or
other quality racing games,
such as Wipeout 2048 for the
PlayStation Vita). RAGE looks
phenomenal on the Retina
display, but it—Llike Dead
Space—has been reduced to
an on-rails shooting gallery.
Sonic and Soul Calibur are
both crippled by less precise,
less responsive controls.

| could go on, but | hope

you get my point: | love the
iPhone for gaming, but it’s

N submit your questions to: comments@maximumpecom
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at its best with games that
embrace the limitations of
the form factor, rather than
pretend they don’t exist.

You Forgot to Hack
in AHCI
In the July 2012 “Operation
Upgrade” article, one of the
“DOs” of upgrading was to
make the jump to AHCI. In
that little tip, you said Win-
dows 7 will fail to boot if you
don’t switch to AHCI during
a clean install. However, you
can get around this by editing
the registry. You go to HKEY_
LOCAL_MACHINE/SYSTEM/
CurrentControlSet/services/
msahci. Change value of Start
to “0,” and AHCI will work.
—Calvin Ho

Deputy Editor Gordon Mah
Ung responds: Agreed, Calvin.
I've used that registry change
myself with success and
should have offered that as an
option for those who wish to
enable AHCI after the fact.

I Don't Want to Be
Assimilated!

I moved to China for a few
years after graduating from
university, and I'm plotting

AMD'S FUTURE NEVER
HINGED SOLELY ON

BULLDOZER

a new build when | go back
to visit the States. | love
over-the-top features and
front-panel connectors, but
it seems like every case out
there has some weird Borg-
looking accents or futuristic
pyramids protruding from
the sides or top. | hate gaudy,
neon-lit giant towers! Is there
a case with every bell and
whistle that isn't a fugly piece
of hideous plastic cyborg
crap?! Can | just find a cube-
looking thing that | can put
stuffin?

—Nathan Willingham

SENIOR CASE WRANGLER
NATHAN EDWARDS RESPONDS:
| feel your pain! We have a
new case roundup coming
next month which will have a
few cases (like the Silver-
stone TJ-04E and Corsair
550D) that might be up your
alley. We also like the Fractal
Design Define R3, NZXT H2,
and Antec P280, as far as
clean-looking modern chas-
sis go. In general, Silverstone
and Lian Li trend toward the
clean aesthetic you're looking
for. On the less expensive
side, so do BitFenix, Fractal,
and Cubitek.

Win8 Partition
Remnants
On Page 24 of the June 2012
issue [second paragraph,
last sentence) David Murphy
states that if you install Win8
in dual-boot mode using a
newly created partition, you
will not be able to undo this.
Can’t you delete the Win8
partition and put the hard
drive back to the way it was
before partitioning?
—Howard Rosen

WINDOWS 8 GURU DAVID
MURPHY RESPONDS: Yes, you
can delete the Windows 8
partition to “remove” Win-
dows 8 from your system.
However, the Windows 8
bootloader will remain—a
shadowy reminder of the
operating system you killed.
That’s what | meant by the
comment, as it’'s a wee bit
trickier to restore the boot-
loader back to your Windows
7 version (for example), and
just wiping the partition
clean without first setting the
bootloader back to Windows
7’s (using the Windows 7
Repair function on the DVD)
could lead to unfortunate
results. )

[NOW ONLINE]

THE NOW-MONTHLY MAXIMUM PC PODCAST

After a period of inactivity (caused by a
caustic chemical spill at the Maximum PC
Podcast Refinery), everyone’s favorite tech
talk show is back on the air. Keep your eye
on our podcast directory at bit.ly/ldy1 for a
once-a-month dose of tech news, analysis,
listener calls, and a generous helping of

off-topic rambling!

[NEXT MONTH]

COMING IN

MAXIMUMPE s

OPTIMIZED
FOR MULTI-
THREADING
SEPTEMBER
ISSUE

Dream Machine
2012

Warning: Our annual
confluence of badass
hardware into an even
badder-ass rig is known to
cause heart palpitations
and extreme PC envy.

Mid-Tower
Mayhem

Our roundup of six mid-size
enclosures was delayed

to make room for the GTX
690, but next month you'll
get the full scoop on which
cases make the cut.

File Recovery

Roundup
When disaster strikes

and you find that your
valuable data has been
lost or corrupted, you’'ll
want to know which file/
disk recovery software
can save the day.
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INGREDIENTS INGREDIENTS
PART { URL PART i URL
Case Fractal Design Define R3 www.fractal-design.com Case NZXT Phantom 410 www.nzxt.com
PSU Corsair TX750 V2 www.corsair.com PSU Corsair HX850 WWww.corsair.com
Mobo Asus P8Z77-V www.asus.com Mobo Asus Sabertooth X79 www.asus.com

i Intel Core i5-3570K g i Inteli7-3820 @4.76Hz |
CPU i @3.4GHz i www.intel.com CPU i loverclocked) i www.intel.com

Cooler Master Hyper H Cooler NZXT Havik 120 Wwww.nzxt.com
Cooler : 212 Evo : www.coolermaster.com ¥

: : : Asus GTX 670 DirectCU :
GPU i EVGAGeForce560Ti448 : www.evga.com GPU : 1ToP i www.asus.com

8GB Patriot Gamer H 16GB Corsair Vengeance :
RAM : DDR3/1600 i www.patriotmemory.com RAM : DDR3/1600 i www.corsair.com
Optical Drive Samsung SH-222 Www.samsung.com LG WH12LS39 BD-R :

Optical Drive i burner : www.lg.com

Solid-State H H . .
Drive i 0CZ Agility 31206B i www.ocztechnology.com Solid-State :

g g Drive : 0CZ Agility 3 120GB i www.ocztechnology.com
Hard Drive : Seagate Barracuda3TB : www.seagate.com ; ;

H Hard Drive : Seagate Barracuda3TB | www.seagate.com

i Windows 7 Home : : :
0s i Premium 64-bit i www.microsoft.com ¢ Windows 7 Professional

0s i b4-bit : www.microsoft.com

Approximate Price: $1,340 Approximate Price: $1,870

NOW THAT we've reviewed some lvy Bridge motherboards (see page
72), we feel comfortable making a recommendation: the Asus P8Z77-
V, with the new Core i5-3570K. And now that hard drive prices have
dropped, we've gone for a faster, bigger HDD.

We've had some readers ask why our Baseline rig costs over
$1,300. Maybe baseline is the wrong word—this is a no-BS, sweet-
spot gaming machine that’s forward-compatible and powerful with-
out being overkill. We can, and do, build sub-$1,000 (and sub-$700)
gaming rigs, but they require compromise due to budget constraints.
The Baseline doesn't.

OUR BASELINE is everything you need for high-resolution, high-quality
gaming. Full stop. Butif you add an extra $500 to your budget, you get
more stuff: eight processor threads instead of four, eight RAM slots,
and an upgrade path to a six-core CPU down the line. You also get a
Blu-ray burner and one of the fastest GPUs we've ever tested. This
Sandy Bridge-E rig has remained mostly the same since it debuted
in June, except for the videocard—and the price. We're now recom-
mending Asus’s GTX 670 DirectCU Il TOP (page 74}, which outper-
forms a stock GTX 680 on all of our benchmarks, while being $70
cheaper.
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OUR ULTRA configuration is for the Maximum PC
reader who needs ultra-fast encoding and rendering,
tip-top graphical prowess, and speedy storage. It's
a step above what's necessary for 95 percent of the
population, but a step below Dream Machine. So it's
merely absurd, not absolutely over the top. Speaking
of which: Dream Machine is next month!

The price of our Ultra configuration is down to just
(1) $3,460, thanks mostly to GPU price drops. Instead
of two Radeon HD 7970s, we're recommending a GTX
690. If you're going to have two $500 GPUs in one ma-
chine, you might as well put them on the same card
and save some room and some power.

Intel’'s Core i7-3930K is $570 worth of six-core
madness, and the Corsair H100 cooler makes it
easy to push the CPU to 4.8GHz from its 3.6GHz
stock speed.

Cooler Master’s Cosmos Il case is huge and luxuri-
ous, with plenty of airflow to cool everything, and the
Asus motherboard is great for overclocking and will
hold another GTX 690 if you go absolutely out of your
gourd for power. We're keeping the 256GB Samsung
830 SSD and 6TB of speedy mass storage.

For our complete Best of the Best list of recommended
components, visit www.maximumpc.com/best-of-the-best.

SUGGESTED PAIRINGS

INGREDIENTS i ;
Kick-ass peripherals for
¥ your new rig
PART i URL
Case Cooler Master Cosmos || www.coolermaster.com
i Thermaltake
" Toughpower Grand : MIDRANGE MONITOR
PSU i 1050W i www.thermaltakeusa.com Asus PA238Q
: : $300, ww.asus.com
Mobo i Asus P9X79 Deluxe i www.asus.com
Intel i7-3930K @4.8GHz :
CPU (overclocked) i www.intel.com KEYBOARD . .
Cooler { Corsair H100 i www.corsair.com Razer BlackWidow Ultimate
: : $130, www.razerzone.com
GPU EVGA GTX 690 i www.evga.com
: MOUSE
: 16GB Corsair Vengeance : Cyborg RAT.9
RAM : DDR3/1600 i www.corsair.com $1DO,Www.cyborggaming.com

LG WH12LS39 BD-R

Optical Drive burner www.lg.com

Solid-State Samsung 830 Series H

Drive i 2566B i www.samsung.com
Seagate Barracuda :

Hard Drive : 3TB (x2) { www.seagate.com

GAMING HEADSET
Corsair Vengeance 1500
$100, www.corsair.com

Windows 7 Professional
0s i b4-bit

Approximate Price: $3,460

MAXIMUM PC (ISSN 1522-4279) is published 13 times a year, monthly

SPEAKERS
Corsair SP2500
$205, www.corsair.com

i www.microsoft.com

plus Holiday issue following December issue by Future US, Inc., 4000
Shoreline Court, Suite 400, South San Francisco, CA 94080. Phone: (650)
872-1642. Fax: (650) 872-2207. Website: www.futureus.com. Periodicals
postage paid in San Bruno, CA and at additional mailing offices. News-
stand distribution is handled by Time Warner Retail. Basic subscrip-
tion rates: one year (12 issues) US: $14.95; Canada: US$19.95; Foreign
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1352. Standard Mail enclosure in the following editions: None. Ride-
Along enclosure in the following editions: None. Returns: Pitney Bowes,
PO Box 25542, London, ON NéC 6B2, Canada. Future US, Inc. also pub-
lishes @Gamer, Crochet Today!, Your Knitting Life, Mac|Life, Nintendo
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PC Gamer, and Windows: The Official Magazine. Entire contents copy-
right 2012, Future US, Inc. All rights reserved. Reproduction in whole or
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ten consent of Maximum PC. Products named in the pages of Maximum
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